IMPORTANT! – READ THIS FIRST!

UAN has provided two primary guides for the year end closing process - it is important that you understand the scope and purpose of each before proceeding:

1. The **Year End Checklist** – A form built into the software that provides brief instructions on the *minimum technical requirements* for closing the year in UAN.

2. The **Year End Procedures** booklet – A detailed guide to software tasks for closing the fiscal year. Before beginning, it is essential to understand the organization of this booklet.

   The Year End Procedures booklet will be available on your Windows desktop after installing the year end update disc, in: **UAN Tools → Version Documentation → 2016.1**

   **All UAN users should read the core instructions of the booklet covered in pages 1-30.**

   The Year End Procedures booklet is *not* presented in a standardized ‘one-size-fits-all’ chronological order as one might typically expect. Instead, due to the variety of circumstances in local governments and the flexibility of UAN, the order for completing the activities is adaptable to your particular entity. The core instructions also branch off into two separate sections depending on which type of annual financial reports you choose to file (regulatory or OCBOA).

   Note that many appendices are referenced throughout the core instructions where appropriate. Topics covered in the appendices may or may not be relevant to your entity. The booklet also contains references to the **Housekeeping Manual** used in the related webinars (which is included in the 2016.1 documentation). UAN recommends reviewing this document and the webinars if you have not already done so.

   The Accounting Housekeeping and Payroll Housekeeping webinars can be viewed online by typing the following addresses into your web browser:
   - Accounting: [https://uanlink.ohioauditor.gov/training/accounting/moduletraining/default.html](https://uanlink.ohioauditor.gov/training/accounting/moduletraining/default.html)
   - Payroll: [https://uanlink.ohioauditor.gov/training/payroll/moduletraining/default.html](https://uanlink.ohioauditor.gov/training/payroll/moduletraining/default.html)

   Then scroll to the Housekeeping menu and click the Housekeeping link to view the video.

   It is also *highly* recommended that you fully review the Table of Contents on the next few pages of the Year End Procedures for an overview of what will be required for closing the year, particularly to prepare for processing W-2s (if necessary) and to prepare for the new fiscal year.
**Top Year End Questions & Answers**

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
</table>
| Where can I find the complete set of Version 2016.1 documentation?       | After installing Version 2016.1, it will be available on your desktop in:  
  * UAN Tools → Version Documentation → 2016.1*                                                                                     |
| Where can I get instructions and answers to questions about Temporary Mode? | Refer to Appendix 1: Temporary Mode, starting on page 49 and ‘Step 3: Open Temporary Mode’ starting on page 4 of the Year End Procedures.                                                                 |
| Where can I find the Year End Balances Certificate in UAN?               | Refer to ‘Appendix 5: Year End Balances Certificates’ in the Year End Procedures booklet starting on page 106.                                                                                           |
| How can I import Word or Excel files to submit with my year end filing?  | Only PDF files can be imported. See instructions to save other files to PDF: ‘AFR - Documents Import’ in the Year End Procedures booklet starting on page 57.                                                 |
| The calendar date is January. Why can’t I print a warrant with a December post date? | You can never backdate printed warrants in the UAN software; therefore you cannot print warrants with a 2015 post date after the calendar date has passed December 31, 2015. For more information see Appendix 1: Temporary Mode starting on page 49. |
| Must I submit all inputted data/imported files (e.g. the Hinkle System data, notes to the financial statements, manually inputted report data, etc.) or can I submit some of it later? | All items applicable to the entity are required to be included in your final year end audit submission before the deadline set by the Auditor of State - financial penalties may be assessed for late filings. See the Important Note on page 20. |
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table of Contents</td>
<td>i</td>
</tr>
<tr>
<td>Overview</td>
<td>1</td>
</tr>
<tr>
<td><strong>Step 1: Install Version 2016.1</strong></td>
<td>4</td>
</tr>
<tr>
<td><strong>Step 2: Computer Date</strong></td>
<td>4</td>
</tr>
<tr>
<td><strong>Step 3: Open Temporary Mode</strong></td>
<td>4</td>
</tr>
<tr>
<td><strong>Step 4: Year End Checklist</strong></td>
<td>8</td>
</tr>
<tr>
<td>4A - Batch Transactions</td>
<td>8</td>
</tr>
<tr>
<td>4B - Annual Financial Reports</td>
<td>9</td>
</tr>
<tr>
<td>4C - Entity &amp; Fiscal Officer</td>
<td>11</td>
</tr>
<tr>
<td>4D - Hardware &amp; Mailing</td>
<td>11</td>
</tr>
<tr>
<td>4E - Next Year FO &amp; Details</td>
<td>11</td>
</tr>
<tr>
<td>4F - AFR Demographics &amp; Debt</td>
<td>12</td>
</tr>
<tr>
<td>4G - Carryover Purchase Orders</td>
<td>15</td>
</tr>
<tr>
<td>Close Purchase Orders</td>
<td>15</td>
</tr>
<tr>
<td>Adjust (Or Reduce) Purchase Orders As Needed</td>
<td>15</td>
</tr>
<tr>
<td>P.O. Frequently Asked Questions</td>
<td>16</td>
</tr>
<tr>
<td>4H - Carryover Withholdings</td>
<td>16</td>
</tr>
<tr>
<td>4I - Removable Items</td>
<td>17</td>
</tr>
<tr>
<td><strong>Step 5: Bank Reconciliation</strong></td>
<td>18</td>
</tr>
<tr>
<td>Post The December 31st (Year End) Bank Reconciliation</td>
<td>18</td>
</tr>
<tr>
<td>Voiding The Year End Bank Reconciliation (If Needed)</td>
<td>18</td>
</tr>
<tr>
<td><strong>Step 6: Computer Date</strong></td>
<td>18</td>
</tr>
<tr>
<td>📊 Finish: Close The Year</td>
<td>19</td>
</tr>
</tbody>
</table>
Print 2010 Prior Year Reports *(If Applicable)* .......................................................... 19
Final Review .................................................................................................................. 19
Verify Employees’ Social Security Number and Address ........................................ 20
Print Year End Reports Before Closing (Recommended) ...................................... 20
Close The Year ............................................................................................................ 21
  1 - UAN Backup – 2015 Year End ................................................................. 23
  2 - UAN Backup – 2016 Year Begin ............................................................... 24
  3 - AFR – AOS Backup For The 2015 Audit Submission .................................. 25
Confirm The Software Is In The New Year .............................................................. 27
Confirm Fund Balances Carried Forward .............................................................. 27
Important First Steps After Closing The Year ...................................................... 27
Meeting Annual Reporting Requirements For The Auditor Of State ........ 28
Publication Requirements ......................................................................................... 29
Other Considerations For The New Year ............................................................... 30

**OPTION #1 For Step 4B  OCBOA Reporting** ...................................................... 32
AFR - Fund Utility ........................................................................................................ 32
  1 - Governmental Fund Classification Tab ...................................................... 33
  2 - OCBOA – Fund Information Tab ................................................................. 35
  3 - OCBOA – Revenue Programs Tab ............................................................... 39
  4 - OCBOA – Fiduciary Accounts Tab ............................................................... 41
  5 - OCBOA – Internal Service Adjustments Tab ............................................. 42
AFR - Component Units ......................................................................................... 43

**OPTION #2 For Step 4B  Regulatory Reporting** ................................................ 45
AFR - Fund Utility ........................................................................................................ 45
  Governmental Fund Classification Tab ............................................................... 46
Appendix 1: Temporary Mode ................................................................. 49

Appendix 2: Year End Reports ............................................................... 53

  Overview ........................................................................................... 53
  AFR - OCBOA Statements ............................................................... 55
  AFR - Documents Import ................................................................. 57
  AFR - Regulatory Statements ......................................................... 60
  AFR Requiring Manual Input ......................................................... 62
  1095 & 1094 Forms ....................................................................... 66
  1099-Misc & 1096 Forms ................................................................. 68
  December 31st Year-To-Date Reports ............................................ 70
  Payroll End of Year Reports ......................................................... 71
  944 Federal Annual Tax Return .................................................... 72
  W-2 & W-3 Forms ......................................................................... 73

Appendix 3: New Year Accounting Procedures ....................................... 93

Appendix 4: New Year Payroll Procedures ............................................. 98

Appendix 5: Year End Balances Certificates ......................................... 106

Appendix 6: Mapping Funds ............................................................... 110

Appendix 7: Recreate AFR – AOS Backup File / Disc If Needed ............... 111
Entities using UAN are required to complete various procedures to close 2015 and advance to 2016. This booklet will guide you through those procedures. The actual year-closing process is completed via a “to-do list” incorporated into the software – the Year End Checklist.

**STEPS TO ACCESS:**
General ➔ Maintenance ➔ Year End ➔ Year End Checklist, then click [Current Year]

**IMPORTANT**

The Year End Checklist provides brief instructions on the MINIMUM technical requirements for closing the year in UAN, while this booklet includes additional detail and other important steps and considerations. The Table of Contents provides a ‘big picture’ of the material in this booklet. It is great as a quick reference guide to keep on hand while completing year end.

**All UAN users should read the core instructions of the booklet covered in pages 1-30.** However, due to the variety of circumstances in local governments and the flexibility of UAN, the order for completing the activities is adaptable to your particular entity. Some topics covered in the remainder of the booklet (primarily the appendices) may not apply to your entity. Note that the appendices are referenced throughout the core instructions, where appropriate.

*Example of an incomplete Year End Checklist:*
USING THE CHECKLIST

The tab pages on the Year End Checklist operate similarly to the UAN bank reconciliation:

- The checklist can be saved even if incomplete, and revisited later as needed.
- Click [Save] and then [Close] if you need to exit the Year End Checklist.
- It is recommended (but not necessary) to complete the steps in the order listed. For example, entities choosing not to utilize Temporary Mode (work in 2016 before closing 2015) may choose to complete “Step 3 - Open Temporary Mode” right before closing fiscal year 2015.
- You can view any of the steps at any time to see what is left to do and how to complete it.
- The icons in the checklist are read-only status icons. Clicking them will not initiate an action.

Note: The year end checklist may only be accessed while working in 2015.

= Complete - This green ✔ icon next to a step means that step is complete.

= Incomplete - This red ✗ icon next to a step means at least one portion is incomplete.

= Information - Steps 4C, D, E, F & I must have this blue icon before the year can be closed. However, this icon does not necessarily ensure that the steps are accurate or appropriate. For example, step 4C requires a contact phone number. The 4C icon may change from ✗ to ✔ after a number has been entered, regardless of whether that number is accurate.

= Caution! - This yellow ! icon applies to steps 4G & 4H. It does not necessarily indicate a problem, and it will not prevent you from closing the year. These steps are included as important reminders. Carefully review the information in these steps! For example, step ‘4G – Carryover Purchase Orders’ will always display the ! icon, whether or not the fiscal officer desires to carry over the purchase orders listed on the tab (if any).

= Click Tip - These small blue ? icons are clickable, and will display helpful popup messages related to any area of the checklist in which they are located.

= Year End Checklist is NOT complete (red flag)

Some steps are incomplete. Review the checklist for steps marked ✗ and complete them.

= Year End Checklist is complete (green flag)

The minimum requirements to close the year in UAN have been met.
CHECKLIST SUMMARY

1) The UAN software version 2016.1 or higher must be installed before the Year End Checklist will be accessible.

2) The UAN computer / calendar date must be in or after December 2015.

3) Temporary Mode must be opened (see important notes in that section).

4) Year End Checklist: complete A-F and review tabs G-I:
   A. All current batch transactions must be posted or deleted.
   B. Select the desired annual financial report type (and complete all utilities related to the type selected).
   C. Enter contact information and verify entity information.
   D. Enter state-owned hardware tag numbers and entity addresses.
   E. Enter new year’s fiscal officer details and acknowledge important notices (if any).
   F. Select a Demographics & Debt submission type and enter values (when applicable).
   G. Review open purchases orders that will carry over (if any).
   H. Review unpaid payroll withholdings that will carry over (if any).
   I. Checkmark items to be removed when closing the year (if any).

5) Post the bank reconciliation for December 31st.

6) The UAN computer / calendar date must be in or after January 2016.

Finish–close the year. Three backups will be created during the closing process:
   1. 12/31/2015 UAN backup 2015 year end (to be retained with the entity)
   2. 01/01/2016 UAN backup 2016 year begin (to be retained with the entity)
   3. AFR- AOS backup (for submission to the Auditor of State)

YEAR END REPORTS

Please note that year end report printing is addressed within the Year End Checklist instructions, and is fully explained in to Appendix 2: Year End Reports starting on page 53. All year end reports may be printed before or after closing 2015.
STEP 1: INSTALL VERSION 2016.1

You must install UAN version 2016.1 (the year end update). Please note that installing it does not automatically open Temporary Mode or advance the software to 2016. If you require any prior update discs, contact UAN Support at 1-800-833-8261.

STEP 2: COMPUTER DATE

The UAN computer date (i.e. calendar date) must be in December 2015 or later.

STEP 3: OPEN TEMPORARY MODE

Temporary Mode includes both the Accounting and Payroll modules. You must manually initiate the opening of Temporary Mode, but it will close automatically when you close fiscal year 2015.

This step will verify that Temporary Mode has been opened. Temporary Mode allows you to work in both fiscal years 2015 and 2016 before closing fiscal year 2015. Please note:

- Opening Temporary Mode is required as part of the year end process.
- Working in 2016 before closing 2015 (i.e. using Temporary Mode) is OPTIONAL.

Entities choosing not to use Temporary Mode may prefer to complete the rest of the Year End Checklist before “Step 3 - Open Temporary Mode”, and then immediately close fiscal year 2015. However, UAN highly recommends using this outstanding feature. A list of its many advantages and detailed information is located in Appendix 1: Temporary Mode, starting on page 49. Please review that appendix before continuing with this step.

Report Year

During and after temporary mode, reports can be produced for either 2015 or 2016 regardless of the computer date and regardless of the work year selected at login. The report year (listed at the top left of most report areas) will default to the current work year, but can be changed as desired.

OPENING TEMPORARY MODE:

STEPS TO ACCESS

General ➔ Maintenance ➔ Year End ➔ Open Temporary Mode

When you click Open Temporary Mode, the software will display a message: Verifying database integrity, please wait... Please be patient while the software takes a few minutes to verify that
your financial data is internally consistent. If the software detects any problems, it will display a message with directions. If no errors are detected, the following system message will appear:

![System Message](image)

To continue, click [OK] and the software will open a Year End Renaming form.

*The following picture is an example of the form with sample withholding names.*

![Year End Renaming Form](image)

On this form, withholdings not specifically pre-set by UAN can be renamed for fiscal year 2016.
IMPORTANT: This renaming is **only** possible when opening Temporary Mode - you **cannot** change existing withholding names **at any other time** during the year.

If you need more time to consider withholding name changes, click [Cancel] to stop the Temporary Mode opening process. If instead you are ready to continue, enter the desired changes (*if any*) under the “Revised Name” column. When you are finished, click [Save].

**Please be patient:** The software will begin creating the data records required for the new year. Processing time for small to mid-size entities could be less than 1 minute – however, the processing time for *large* entities may be up to 10 minutes or more.

After the processing is complete, a system message will be displayed:

![System Message](image)

Read the message carefully and click [OK] to continue. The software will automatically close.

Double-click on the UAN icon 🏛️ to reopen the software. Now that the software is operating in Temporary Mode, you may select the work year upon login (as seen below):

![User Login](image)
Notice the radio buttons above the User Name: “Work Year: ☑ 2015 ☒ 2016”. Each time the User Login form is opened while in Temporary Mode, the work year will default to ☑ 2015. Select the year that you would like to work in and then enter your user name and password. Click [OK] to log in, and a system message will be displayed:

![System Message](image)

Read the message carefully and click [OK] to continue. When the software opens, notice that the top right of the main menu displays a Temporary Mode notification:

![Temporary Mode](image)

The work year that you selected on the User Login form will be displayed, as well as the date upon which 2016 will become unavailable on the login form (if 2015 has not yet been closed).

**Reminder:** Temporary Mode will close automatically when you close the fiscal year 2015.

**Recommendation:** Payroll users should review the Payroll Housekeeping section of the Housekeeping Manual which is included with the 2016.1 documentation or can be accessed on UAN Link by clicking the link below or typing it into your web browser address field
https://uanlink.ohioauditor.gov/training/payroll/moduletraining/default.html and scrolling to Housekeeping section.
STEP 4: YEAR END CHECKLIST

IF NEEDED, REOPEN THE YEAR END CHECKLIST:
General → Maintenance → Year End → Year End Checklist, then click [Current Year]

Complete checklist tabs A-F and review tabs G-I. Reminder: These requirements do not have to be completed in a particular order, or in a single sitting.

4A - BATCH TRANSACTIONS

All 2015 batch transactions must be posted or deleted before closing the year. Batch transactions are listed in the areas referenced in this section. Menu paths are listed beside the transaction type.

Accounting-Only clients – batch EFT, Wages, Withholding Payments, and Withholding Adjustments are not applicable for you.

Accounting & Payroll clients – For payroll batch item details, please refer to the Housekeeping Manual which is included with the 2016.1 documentation or can be accessed on UAN Link by clicking the link below or typing it into your web browser address field https://uanlink.ohioauditor.gov/training/payroll/moduletraining/default.html and scrolling to the Housekeeping section.

Important Reminders
All cash transactions (like posting interest revenue for the primary checking account) and related utility functions needed for the fiscal year should be posted before completing the annual financial report utilities (Step 4B) and before posting the 12/31 bank reconciliation (Step 5), to prevent having to repeat these steps.

Investment and/or secondary checking account balances in UAN should match the corresponding bank statement balances. All transactions must be entered for the accounts before closing the year, including interest or fees posted at the bank on December 31st. For a detailed discussion of this, please refer to the Housekeeping Manual which is included with the 2016.1 documentation or can be accessed on UAN Link by clicking the link below or typing it into your web browser address field https://uanlink.ohioauditor.gov/training/accounting/moduletraining/default.html and scrolling to the Housekeeping section.
The Auditor of State recommends, but does not require, submission of GAAP ‘look-alike’ statements – referred to as OCBOA statements (Other Comprehensive Basis of Accounting). Select the Annual Financial Report (AFR) Filing Type that you would like to include with the audit submission when the year is closed:

**OCBOA Modified Cash Basis**
Select this option if you will be filing GAAP ‘look-alike’ statements and the entity has at least one non-pooled investment.

**OCBOA Cash Basis**
Select this option if you will be filing GAAP ‘look-alike’ statements and the entity has zero non-pooled investments.

**Regulatory**
Select this option if you elect not to present GAAP ‘look alike’ statements.

The status icons refer to sections in the AFR – Fund Utility, which is discussed in detail in this booklet. The numbers next to the status icons reflect any remaining items in those areas that must be completed before closing the year. If any cash transactions are posted after completing the fund utility, the funds involved in those transactions may be changed to incomplete.

**Governmental Fund Classification**
The status sections labeled OCBOA only apply to OCBOA filing – note that they are hidden if Regulatory is selected. Conversely, all entities are required to complete the Governmental Fund Classification (GASB 54) page of the AFR – Fund Utility, explained below.

**GASB 54**
In February 2009, The Governmental Accounting Standards Board (GASB) released Statement 54, Fund Balance Reporting and Governmental Fund Type Definitions, to enhance uniformity and understanding of what constitutes ‘net’ fund balances and any restrictions placed on them. Paragraph 5 of the Statement reads:

“The statement establishes fund balance classifications that comprise a hierarchy based primarily on the extent to which the government is bound to honor constraints (restrictions or limitations) on the specific purposes for which amounts in the fund can be spent. Fund balance amounts are to be classified according to GASB 54 requirements and can be classified in one of five components: Non-Spendable, Restricted, Committed, Assigned and Unassigned.”

In addition, Local Government Services has provided UAN with a Fund Purposes guide. The complete versions of both the AOS Bulletin 2011-004 and the Fund Purposes guide are included with the UAN version 2016.1 documentation.

If you have any questions about fund classifications after reading the bulletin, please contact Local Government Services at 1-800-345-2519. UAN Support cannot answer such questions.

**GASB 54 in UAN**

The government fund classification page of the AFR – Fund Utility must be completed by **ALL** entities, regardless of whether you are filing OCBOA or Regulatory annual reports. Skip to the section for your chosen filing type as specified below, then return back to this point to continue.

- **If filing OCBOA statements, see Option #1 starting on page 31.**
  This includes instructions for GASB 54 and GASB 34 GAAP ‘look-alike’ statements.

- **If filing Regulatory statements, see Option #2 starting on page 44.**
  This includes instructions for GASB 54 requirements only.

If you closed the Year End Checklist while completing the AFR – Fund Utility, reopen it at:

**STEPS TO ACCESS:**
General → Maintenance → Year End → Year End Checklist, then click [Current Year]

Next review and/or edit the year end checklist tabs listed next:
### 4C - ENTITY & FISCAL OFFICER

Enter your contact information and verify the fiscal officer name(s) and entity information.

If you need to edit fiscal officer names or entity tax IDs:

**STEPS TO ACCESS:**
- General  ➔ Maintenance  ➔ Entity Setup

### 4D - HARDWARE & MAILING

**UAN Hardware Tags**

Enter tag numbers from the state-owned hardware listed. Click the icons for tag location descriptions and photos. **Note**: Laptop users do NOT need to enter a Monitor tag number.

**UAN Hardware Address:**

Enter your hardware shipping address. This must be a physical location. **Do not enter a PO Box**.

**Mailing Address:**

Enter your mailing address – the location UAN should mail physical correspondence to you.

### 4E - NEXT YEAR FO & DETAILS

Enter next year’s fiscal officer details (if known) and indicate your acknowledgment of the important notices listed (if any).

**New Year’s Fiscal Officer:**

- ☑ Same as current fiscal officer
  - Select this button if the current fiscal officer will be the new year’s fiscal officer.

- ☑ Newly elected/appointed fiscal officer
  - Select this button if the fiscal officer in the new year is newly elected or newly appointed.
  - Then fill in the ‘as of’ date, name, address, phone and email address.

**Details:**

In order to plan future UAN training sessions and update UAN training materials, please answer the following questions by selecting the applicable radio buttons on the form.
Note: to view all 3 questions on the Year End Checklist, click the windows maximize button to expand the window to full screen size or use the scroll arrows located on the right side of the form.

1. How many years of experience do you have as a UAN Fiscal Officer? 
   Select the applicable range.
2. Do you have convenient access to high speed internet? 
   Select Yes or No.
3. Do you provide self-insured medical coverage for your employees? 
   Select Yes or No.

4F - AFR DEMOGRAPHICS & DEBT

Select a submission type:
- Submit through UAN with AFR filing (recommended & the system default)
- Complete the Hinkle System* requirements online (GAAP/FASB)
  *The Hinkle System was previously named AFDRS

- Submit through UAN with AFR filing (recommended) – You wish to submit the FINAL Hinkle System information using UAN. This option is recommended for the majority of UAN users, as you will NOT be required to use the online Hinkle System after UAN receives your year end submission.

- Complete the Hinkle System requirements online (GAAP/FASB) – You do not wish to use the UAN software for this step. You should only select this submission type if you will be filing true GAAP financial statements. In other words, if you will not be using one of the AFR filing options facilitated through the UAN software (Regulatory or OCBOA – GAAP ‘look-alike’) as your final submission to the Auditor of State, but will instead prepare true GAAP annual financial statements. This submission type is not recommended for entities of any other circumstance.

With this option, the online Hinkle System MUST be used to submit these figures within the deadline set by the Auditor of State’s Office. For guidance, contact the auditor’s Center for Audit Excellence at 1-800-282-0370.

Upon selecting this submission type the software will require you to enter an Override Password. **You must contact UAN Support to request an override password before you will be able to continue with this option.** Again, this is not recommended for entities unless you are filing true GAAP (not to be confused with OCBOA ‘GAAP look-alike’) financial statements.
WHEN USING THE ‘AFR DEMOGRAPHICS & DEBT’ LIST GRID

To meet the minimum technical requirement for completion of this section, townships and villages must enter a value in the ‘Population’ field while libraries must enter the ‘Number of Patrons’. However, all values applicable to the entity are required to be entered here for your final year end audit submission before the deadline set by the Auditor of State - financial penalties may be assessed for late filings.

**Recommendation:** By using Temporary Mode you might gain some extra time to complete these items before closing the fiscal year.

**Note for special districts:** the grid list is intentionally blank since special districts are required to choose a submission type, but are not required to enter additional data.

**Note:** Debt information must not include any premiums / discounts on debt insurance, nor any gains / losses on debt refunding or long-term compensated absences, claims, or pension liabilities. For guidance, contact the auditor’s Center for Audit Excellence at 1-800-282-0370.

Many values may not be known until after the end of the year. It is recommended that you gather information such as population, tax rate, assessed property tax valuation and debt (only the items applicable to your entity) as soon as possible so you are prepared to enter those values in UAN. For your convenience, the AFR Demographics & Debt items applicable to each entity type are listed in the tables below (as they will appear on the Year End Checklist 4F tab). If you wish to verify the ‘**Calculated**’ amounts that automatically populate the grid, in Accounting → Reports and Statements find the **Final Appropriation Total** for all funds on the **Appropriation Status**, and the **Unencumbered Fund Balance** for the General fund on the **Fund Summary** report.

<table>
<thead>
<tr>
<th>TOWNSHIPS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Population</td>
</tr>
<tr>
<td>Total Annual Final Appropriations for All Funds for the Reporting Year</td>
</tr>
<tr>
<td>Full Tax Rate Per $1,000 of Assessed Valuation</td>
</tr>
<tr>
<td>Total Assessed Property Tax Valuation</td>
</tr>
<tr>
<td>Unrestricted General Fund Carryover Cash Balance at Year End</td>
</tr>
<tr>
<td>Governmental Funds - General Obligation Bonds</td>
</tr>
<tr>
<td>Governmental Funds - Special Assessment Bonds</td>
</tr>
<tr>
<td>Governmental Funds - Notes Payable</td>
</tr>
<tr>
<td>Governmental Funds - Loans Payable</td>
</tr>
<tr>
<td>Governmental Funds - Capital Leases</td>
</tr>
<tr>
<td>Governmental Funds - Revenue Bonds</td>
</tr>
</tbody>
</table>
### VILLAGES

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Population</td>
<td></td>
</tr>
<tr>
<td>Total Annual Final Appropriations for All Funds for the Reporting Year</td>
<td><em>(Calculated)</em></td>
</tr>
<tr>
<td>Average Number of Utility Customers</td>
<td></td>
</tr>
<tr>
<td>Full Tax Rate Per $1,000 of Assessed Valuation</td>
<td></td>
</tr>
<tr>
<td>Total Assessed Property Tax Valuation</td>
<td></td>
</tr>
<tr>
<td>Unrestricted General Fund Carryover Cash Balance at Year End</td>
<td><em>(Calculated)</em></td>
</tr>
<tr>
<td>Governmental Funds - General Obligation Bonds</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Special Assessment Bonds</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Notes Payable</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Loans Payable</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Capital Leases</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Revenue Bonds</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Miscellaneous Long Term Bonds</td>
<td></td>
</tr>
<tr>
<td>Proprietary Funds - General Obligation Bonds</td>
<td></td>
</tr>
<tr>
<td>Proprietary Funds - Special Assessment Bonds</td>
<td></td>
</tr>
<tr>
<td>Proprietary Funds - Notes Payable</td>
<td></td>
</tr>
<tr>
<td>Proprietary Funds - Loans Payable</td>
<td></td>
</tr>
<tr>
<td>Proprietary Funds - Capital Leases</td>
<td></td>
</tr>
<tr>
<td>Proprietary Funds - Revenue Bonds</td>
<td></td>
</tr>
<tr>
<td>Proprietary Funds - Miscellaneous Long Term Bonds</td>
<td></td>
</tr>
</tbody>
</table>

### LIBRARIES

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Patrons</td>
<td></td>
</tr>
<tr>
<td>Yearly Circulation</td>
<td></td>
</tr>
<tr>
<td>Full Tax Rate Per $1,000 of Assessed Valuation <em>(if applicable)</em></td>
<td></td>
</tr>
<tr>
<td>Total Assessed Property Tax Valuation <em>(if applicable)</em></td>
<td></td>
</tr>
<tr>
<td>Unrestricted General Fund Carryover Cash Balance at Year End <em>(Calculated)</em></td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - General Obligation Bonds</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Notes Payable</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Loans Payable</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Capital Leases</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Revenue Bonds</td>
<td></td>
</tr>
<tr>
<td>Governmental Funds - Miscellaneous Long Term Bonds</td>
<td></td>
</tr>
</tbody>
</table>
4G - CARRYOVER PURCHASE ORDERS

All purchase orders that are currently open will be listed here. This is useful information to review so that you can close any that are not needed, or reduce any with balances in excess of what will be needed for 2016.

Reminder: There are four purchase order types: PO Regular, PO Then & Now, BC Regular, and BC Super. *The instructions below refer to all types as purchase orders.*

CLOSE PURCHASE ORDERS

Purchase orders that have zero available balance will automatically close when you close the year. **All others will carry forward if you do not close them.** Be sure to post all 2015 payments against them before closing. If necessary, you may carry any purchase order into the new year.

**STEPS TO ACCESS**
Accounting → Utilities → Purchase Order Utility; Click the [Need Help] button or FAQs menu links for more information on closing.

**IMPORTANT**

After a purchase order is carried over to fiscal year 2016 (*i.e. it is left open when you close year 2015*), it cannot be reduced and closing it in 2016 will **not** increase the unencumbered balance available for appropriations in 2016. See the FAQs below for details.

ADJUST (OR REDUCE) PURCHASE ORDERS AS NEEDED

Reduce purchase orders as needed. Purchase orders with an available balance in excess of what was or will be necessary for 2016 can be reduced to avoid unnecessary carryover encumbrances.

**STEPS TO ACCESS**
Accounting → Utilities → Purchase Order Utility; Click the [Need Help] button or FAQs menu links for more information on adjusting.
P.O. FREQUENTLY ASKED QUESTIONS

- When should I carry forward purchase orders?
- What effect will carryover purchase orders have on my 2016 budget?
- How does a purchase order opened in 2015 get carried forward to 2016?

For a detailed discussion of this, please refer to the Housekeeping Manual which is included with the 2016.1 documentation or can be accessed on UAN Link by clicking the link below or typing it into your web browser address field https://uanlink.ohioauditor.gov/training/accounting/moduletraining/default.html and scrolling to the Housekeeping section.

4H - CARRYOVER WITHHOLDINGS

Current unpaid withholdings are displayed in this section for your review. This step is not applicable to Accounting-Only UAN clients.

This is useful information to review so that you can:
- Confirm unpaid withholdings that should be carried over to be paid in 2016.
- Identify unpaid withholdings that should be paid in 2015.
- Identify unpaid withholdings that should be cleared from the Payroll module in 2015 because they have been (or will be) paid through the Accounting module.

All withholdings left unpaid when closing 2015 will carry over to be paid in 2016. Resources available for appropriations in 2016 will be reduced by the carryover unpaid employee and fringe benefit withholdings.

IMPORTANT

Clearing an unpaid withholding after it is carried over to fiscal year 2016 will NOT increase the new year’s available resources (just like Purchase Orders, discussed above).

Note: Carryover balances are calculated when 2015 is closed, not when opening Temporary Mode. You CAN still pay or clear carryover withholdings during Temporary Mode.

If you have identified items that should be paid or cleared in 2015, you should investigate further so they can be paid or cleared before you close 2015. The Housekeeping Manual is provided for those who would like more detailed instructions on how to identify and resolve unpaid
withholdings, overpaid withholdings, and other payroll housekeeping items. All Payroll users should review this prior to December 31, 2015. The Housekeeping Manual is included with the 2016.1 documentation or can be accessed on UAN Link by clicking the link below or typing it into your web browser address field
https://uanlink.ohioauditor.gov/training/payroll/moduletraining/default.html and scrolling to the Housekeeping section.

4I - REMOVABLE ITEMS

Review the lists in each tab for items that will no longer be needed in 2016. Marked items will automatically be removed when 2015 is closed.

This section only includes items that will be considered removable after closing the year. Using this section is optional. After the year is closed, as long as a particular item has no activity affecting its removable status, it can still be removed using the typical method (the [Remove] button in its corresponding maintenance area).

Please Note
- Items marked for removal will ONLY be removed upon closing the year, and ONLY from 2016 records. It will have no effect on your 2015 reports. For example, if you remove an employee who was paid in 2015, you will still have access to print 2015 reports for that employee after closing 2015 (such as forms W-2 and W-3).
- If you checkmark an item and then later use or modify it before closing 2015, it might not be removed. For example, if you mark an appropriation code to be removed, but later use that code to create a purchase order that carries over to 2016, then it will not be removed.
- An item’s status (active / inactive) has no bearing on whether it can or will be removed.

REVENUE / APPROPRIATION TAB

If you choose to remove any account codes that will no longer be needed starting in fiscal year 2016, place a checkmark next to the revenue and/or appropriation accounts on this tab.

EMPLOYEES TAB

If you choose to remove any employees that will no longer be needed in the new year, place a checkmark next to the employee(s) on this tab. Marked employees will be permanently removed from 2016 records when you close the year.
STEP 5: BANK RECONCILIATION

Important Reminders
You cannot forward-date bank reconciliations, thus you cannot add the December 31st bank reconciliation until the computer date (calendar date) is on or after 12/31/2015. Please review the Important Reminders listed on page 8 of this booklet before posting this bank reconciliation.

POST THE DECEMBER 31ST (YEAR END) BANK RECONCILIATION

The December 31st (year-end) bank reconciliation must be posted before closing the year. The year end bank reconciliation is added and posted just like any other bank reconciliation:

STEPS TO ACCESS
Accounting → Transactions → Bank Reconciliation, then click the [Need Help] button or FAQs menu links for more information.

IMPORTANT: The year end bank reconciliation MUST be dated 12/31.

VOIDING THE YEAR END BANK RECONCILIATION (IF NEEDED)

If the December 31st bank reconciliation is in batch (saved but not posted), it can be edited or deleted like any other bank reconciliation in Accounting → Transactions → Bank Reconciliation.

If the December 31st bank reconciliation has been posted, it can be voided if necessary. Voiding the bank reconciliation changes the status of all items marked cleared and/or voided on that reconciliation back to ‘outstanding’ and deletes the reconciliation.

STEPS TO ACCESS
Accounting → Utilities → Bank Reconciliation Utility
Place a checkmark beside the 12/31 bank reconciliation and click the [Void] button. A bank reconciliation that has been voided will no longer appear in the list form to select.

STEP 6: COMPUTER DATE

The computer/calendar date must be on January 1, 2016 or later before the year can be closed.
PRINT 2010 PRIOR YEAR REPORTS (IF APPLICABLE)

2010 reports will be removed from the UAN computer upon the installation of version 2016.2, which is expected to be released near the end of March or beginning of April in 2016. The UAN software retains five prior years of reports. If you do not already have printed copies of your 2010 reports, you must print them before they are removed. Note: UAN Support cannot recommend which reports to print.

This reminder is for those who were not in office at that time and do not know if 2010 year end reports were printed by a previous fiscal officer. If you were in office at the time and you know you printed the reports, then you do not need to re-print those reports. If you are unsure for any reason, you should check your files to determine if you need to print them. The reports can be viewed and printed by following the steps below:

1. Double-click on the UAN Tools icon on your computer’s Desktop
2. Double-click on the Prior Year Reports icon
3. Double-click on the 2010 icon

The system will prompt you for a password. If you do not know your prior year reports password, follow the procedures for password resets as outlined in the Prior Year Reports section of the Housekeeping Manual – which is included with the 2016.1 documentation or can be accessed on UAN Link by clicking the link below or typing it into your web browser address field https://uanlink.ohioauditor.gov/training/accounting/moduletraining/default.html and scrolling to the Housekeeping section.

FINAL REVIEW

Review all tabs in the year end checklist for accuracy and address any that have the incomplete status icon . After you have completed the minimum system requirements to close the year, the Finish flag icon will change from red to green indicating the checklist is complete.
VERIFY EMPLOYEES’ SOCIAL SECURITY NUMBER AND ADDRESS

When fiscal year 2015 is closed, edits to an employee’s social security number or their address will not update on the 2015 W-2 forms or 1095 forms. Make sure to verify this information before closing the year and before these forms are printed. See the Employee Information section on page 73 for steps to verify.

PRINT YEAR END REPORTS BEFORE CLOSING (RECOMMENDED)

Year end reports may be printed before or after closing the year, but UAN recommends printing them before closing the year so that you can focus on the new year’s activities afterward. Make note of the year end reports relevant to your entity and be sure to complete them, whether you choose to do so before or after closing the year. Detailed instructions are included in Appendix 2: Year End Reports starting on page 53.

Important Note
Some year end reporting requires manual type-in or the importing of documents created outside of the UAN software for the year end audit submission file (or disc). You are required to include these in your final year end audit submission before the deadline set by the Auditor of State - financial penalties may be assessed for late filings.

For more information, review the following:
- AFR Requiring Manual Input (page 62)
- AFR - Documents Import (page 57)
- 4F - AFR Demographics & Debt (page 12) i.e. the Hinkle System

Recommendation: By using Temporary Mode you might gain some extra time to complete these items before closing the fiscal year.
If you exited the Year End Checklist while completing the requirements above, reopen it at:

**STEPS TO ACCESS:**
General → Maintenance → Year End → Year End Checklist, then click [Current Year].
Then click on the Finish [Close The Year] tab.

Click [Close 2015] to close the year. If the button is shaded gray (i.e. *if you click it, nothing happens*), that means that some steps on the year end checklist are incomplete. These must be completed before you can continue. Review the tabs with the incomplete status icon and complete what is required. After addressing these issues, the Finish flag icon will change from red to green indicating the checklist is complete. Click [Close 2015] to begin the process. After a moment of processing (*verifying database integrity*) you should receive this message:

![System Message]

Click [OK] if you wish to continue and you should receive this message:
Click [OK] if you wish to continue.

The system will check the Auditor and Computer tag numbers that you entered in ‘Step 4D - Hardware & Mailing’ to confirm that they are valid numbers. If potential errors are detected, the system will display a message encouraging you to double-check the numbers. If the actual tag number(s) do not match those displayed in the message, click [Cancel] and re-enter the number(s) before closing the year. If the tag number(s) do match, click [OK] to continue.

If the software does not detect these, or any other problems, it will prompt you to create three backups (1 - Year End, 2 - Year Begin, and 3 - AFR – AOS), described on the following pages:
The entire year’s activity will be backed up before fiscal year 2015 will close. After following the steps on the previous page, a message will appear. Read the message carefully and click [OK]. Then the first of the three backup forms will open: ‘UAN Backup – Year End 2015 – Backup 1 of 3’.

This form operates exactly like any other UAN Backup required throughout the year. Choose the backup destination, insert the desired media (CD, DVD, flash drive, network drive or other) and click [Start]. UAN strongly recommends that you use a blank CD or DVD, and that you do not reuse it later for any other purpose.

**Reminder:** If needed, detailed instructions for UAN Backups are located in the Accounting & General Manual under the General → Maintenance → Backup section.

When the backup is complete, the backup form will close and a message will open with information about the next backup. If the backup destination was a CD or DVD, then you should immediately remove the disc and label it so that it is clearly distinguished from other discs.

*Suggested label:*

2015 Year End Backup  
Your Entity Name  
Your County Name  
Your UAN Entity ID Number

**Do NOT send this backup to UAN as your 2015 audit submission.**  
This backup is not valid for audit submission (i.e. AFR – AOS backup) and does not satisfy your legal filing deadline! Instead, the backup should be retained by the entity and not included in your backup rotation cycle. The backup media should be stored in a secure place, preferably off-site.
As noted on the previous page, after the first backup is complete a message will open with instructions for completing the second backup. Read the message carefully and click [OK]. The second of the three backup forms will open: ‘UAN Backup – Year Begin 2016 – Backup 2 of 3’.

This form also operates exactly like any other UAN Backup. Choose the backup destination, insert the desired media (CD, DVD, flash drive, network drive or other) and click [Start].

When the backup is complete, the backup form will close and a message will open with information about the next backup. If the backup destination was CD or DVD, then you should immediately remove the disc and label it so that it is clearly distinguished from other discs.

**Suggested label:**

**2016 Year Begin Backup**

Your Entity Name  
Your County Name  
Your UAN Entity ID Number  

Do NOT send this backup to UAN as your 2015 audit submission.

This backup is not valid for audit submission (i.e. AFR – AOS backup) and does not satisfy your legal filing deadline!
3 - AFR – AOS BACKUP FOR THE 2015 AUDIT SUBMISSION

As noted on the previous page, after the second backup is complete a message will open with instructions for completing the third backup. Read the message carefully and click [OK]. The last of the three backup forms will open: ‘AFR – AOS Backup – Year End 2015– Backup 3 of 3’.

You can either create a file to submit online (Option #1) or create a disc to submit by postal mail (Option #2). UAN recommends submitting the file online for entities that have access to a high speed internet connection.

**Option 1: Create a file to submit online:**
Select the backup destination: ‘Internet Submission – E-Files Directory.’ Then click [Start].

When the backup is complete, the backup form will close and a message will appear with instructions for submitting the file to the Auditor of State. The audit submission file will be saved in the C:\_UAN_Efiles directory. The file will be named xxxx_2015_AFR.uan where ‘xxxx’ is your entity’s four digit UAN entity ID number. You will be prompted to select that file when you make the submission online. Carefully read the additional information in the message and click [OK]. Another message will appear stating 2015 is now closed. Log in again to continue. Read the important information in the message about prior year reports and click [OK]. The software will close automatically.

In addition to the on-screen instructions listed above, specific steps for submitting the file to meet the AFR filing requirements for the Auditor of State are outlined in this booklet starting on page 28. However, prior to submission you should confirm that the software is operating in the new year, and that the correct fund balances have carried forward - see page 27 for details.

**To create a disc to mail instead of a file to submit online - see Option 2 on the next page**
**Option 2: Create a disc to submit by mail:**

Select the backup destination: ‘Postal Submission – CD or DVD.’ Insert a blank disc in the CD/DVD tray and close it. Then click [Start].

When the backup is complete, the backup form will close and a message will appear stating your AFR – AOS Backup disc has been created and the disc will be ejected. Immediately label this AFR – AOS Backup disc for audit submission as follows:

2015 AFR
Your Entity Name
Your County Name
Your UAN Entity ID Number

Carefully read the additional information in the message and click [OK]. Another message will appear stating 2015 is now closed. Log in again to continue. Read the important information in the message about prior year reports and click [OK]. The software will close automatically.

In addition to the on-screen instructions listed above, specific steps for submitting the disc to meet the AFR filing requirements for the Auditor of State are outlined in this booklet starting on page 28. However, prior to submission you should confirm that the software is operating in the new year, and that the correct fund balances have carried forward - see page 27 for details.

**To create a file for online submission instead of a disc - see Option 1 on the previous page**
CONFIRM THE SOFTWARE IS IN THE NEW YEAR

Log in to the UAN software. Confirm that there is no longer a Temporary Mode notification in the top right corner and that **Year: 2016** is listed in the status bar in the bottom right hand corner of the UAN software (to the left of the current date).

If 2015 is listed in this status bar instead of 2016, then you have not successfully closed the year. Carefully repeat the closing process outlined in this booklet, starting on page 21. For further assistance, contact UAN Support at uan_support@ohioauditor.gov or 1-800-833-8261.

CONFIRM FUND BALANCES CARRIED FORWARD


**STEPS TO ACCESS**

Accounting ➔ Reports & Statements ➔ Fund Reports, click the report drop-down menu to select Cash Summary by Fund. From the drop-down menus, select the year and the month.

A discrepancy between the two fund balances is normal only if you posted any transactions on 1/1/2016 prior to printing this report. You may confirm this by printing the Cash Journal or Fund Ledger reports to identify January 1 postings. If there is still a discrepancy even after accounting for any January 1 postings, contact UAN Support before continuing with other transactions.

IMPORTANT FIRST STEPS AFTER CLOSING THE YEAR:

**Congratulations!**

You have completed the year end closing process, but don’t forget these important steps:

1) Submit the AFR – AOS submission file (or disc) to UAN to meet the annual financial reporting requirements for the Auditor of State. See instructions on the next 2 pages. **Note:** If needed, you can recreate the AFR – AOS submission file (or disc). See Appendix 7: *Recreate AFR – AOS Backup File / Disc If Needed* starting on page 111 for details.

2) Complete the publication requirements for annual financial reports (see page 29).
Each local government is required to submit their Annual Financial Report to the Auditor of State within **sixty (60) days of the end of the fiscal year**. Meeting this requirement for UAN members occurs when the 2015 AFR file (or disc) containing the end of year filing data of the government is received by UAN.

**Reminder**: the 2015 AFR file (or disc) final submission must also include (when applicable) all Hinkle System data entry, other manually inputted data, and imported documents. See the important note on page 20 for details. **Financial penalties may be assessed for late filings.**

**Option #1: Submitting the file electronically:**
If you chose the ‘E-files Directory’ to send the file electronically, first connect to the internet. Then go to the UANLink website at https://uanlink.ohioauditor.gov/ OR just use the shortcut that is built in the UAN software: click on the Seal of the Auditor of State icon located in the top left corner of the main UAN screen and the UANLink website will open. Then click on ‘Profile Login’ located on the right corner of the page. You will be required to enter a user name (your UAN Entity ID) and a password (your 5-character AOS invoice customer number) to log in. Click on ‘Upload Your Year End File’ and follow the on-screen directions.

Please be patient. The amount of time it will take to upload the file can vary significantly depending on your internet speed and the size of the file. Entities with high speed internet service can expect uploading their year end file to take 1-5 minutes for a file under 50MB, 5-10 minutes for 50-100MB files, or 10-30 minutes for files over 100MB. For entities that use the very slow ‘dial up’ internet (*i.e. not a high speed internet service*), UAN recommends mailing the file on a disc (see option #2 below).

Please note: When you browse websites, you are “downloading” information, but when you transmit a file off the computer to UAN, you are “uploading” information. Internet upload speeds are typically 1/10th as fast as download speeds, so even though you may have a “high speed internet” service that does not necessarily mean you have “high speed uploads” as well.

**Option #2: Mailing the file on a disc:**
If you selected ‘Postal Submission CD or DVD’ to mail the file on a disc, remove the disc from the CD/DVD drive and prepare it for mailing.
As previously noted, the audit submission disc should be labeled in the following manner:

2015 AFR
Your Entity Name
Your County Name
Your Entity ID Number

Please mail the disc to:

Auditor of State of Ohio
Uniform Accounting Network
88 E. Broad St.
Columbus, Ohio 43215

Confirming the status of your submission

Whether submitted by electronic file or disc, confirm the status on the UAN Link website. Please allow 5 business days for postal submissions or 3 business days for internet submissions for UAN to receive and process the file. For your convenience, there are 2 menu shortcuts built into the software which will take you directly to the filing status page. When your computer is connected to the internet, click one of the menu shortcuts listed below:

**STEPS TO ACCESS**

General → Maintenance → Year End → AFR – Filing Status Website *OR*
General → Reports & Statements → Year End → AFR – Filing Status Website

Either option will open the Filing Status page. To access this page from another computer, connect to the internet, open the computer’s web browser, and type in the following address:

https://uanlink.ohioauditor.gov/resources/YearEnd/Default.aspx

The page should list the 2015 Filing Status for all entities. If it lists a different year, click on the 2015 link. Enter your four digit UAN entity ID number in the Entity ID field and then click [Search] to highlight your entity’s status.

**PUBLICATION REQUIREMENTS**

Each local government is required to publish a notice in the local newspaper that the Annual Financial Report is complete and that the report is available at the office of the fiscal officer. The notice needs to be published at the time the UAN member files their Annual Financial Report with the Auditor of State, which is accomplished by submitting the 2015 AFR – AOS file (or disc) to the Auditor of State.
OTHER CONSIDERATIONS FOR THE NEW YEAR

Where do you go from here? After taking a hard earned break 😊, consider the following:

- If you did not already print the year end reports before closing, please see detailed instructions on doing this – starting on page 53, Appendix 2: Year End Reports.

- You can use the Budget software provided by UAN to create the Year End Balances Certificate for submission to the county auditor – see page 106 for details. Using UAN software to prepare this certificate is optional.

- For suggestions on beginning the year, see Appendix 3: New Year Accounting Procedures and Appendix 4: New Year Payroll Procedures starting on page 93. Reminder: Revenue and appropriation budgets are set to zero when the year is closed. However, if you logged into work year 2016 during Temporary Mode and entered your 2016 Revenue Budgets and/or Temporary appropriations, those will remain in place after you close 2015.
2015 Year End Procedures
- OCBOA Reporting -

If you have any further questions about either, please contact Local Government Services at 1-800-345-2519. UAN provides technical guidance in this document for using the AFR Utilities, but cannot suggest selections or entries to make.

**Reminder:** OCBOA statements do not include fund numbers, so it is especially important that funds names are descriptive of the fund purpose and not the system defaults. For example, an enterprise fund should not be named ‘Enterprise’, other miscellaneous capital funds should not be named ‘Other Misc Capital’, etc. To edit fund names:

**STEPS TO ACCESS:**
Accounting → Maintenance → Funds, Click the [Need Help] button for more information.

**AFR - FUND UTILITY**

The fund utility form includes at least 1 tabbed page and a ‘mapping’ section for each fund. Those filing OCBOA AFRs are required to complete all tabbed pages that are listed for each individual fund and – if applicable – the Mapping section.

**STEPS TO ACCESS:**
General → Reports & Statements → Year End → AFR – Fund Utility

All funds – whether active or inactive – will be listed. Mark (fill-in) the checkbox next to the fund or funds you would like to edit first. Click the [Edit] button and the following drop down menu will open:
Click OCBOA and the Edit AFR – Fund Utility form will open. If multiple funds are selected, the navigation arrows at in the bottom left hand corner of the form can be used.

For example, six funds were selected here: . Click the arrows to advance back and forth between funds or move to the first or the last fund selected.

**Mapping**
The Mapping section is for miscategorized or ancillary (subsidiary) funds only. The default setting is ‘Not Mapped.’ Most UAN entities will have no need to map any of their funds. When a fund is ‘mapped to’ another fund, it means the current fund’s balance will be considered part of the selected fund’s balance for the purpose of annual financial statements. If you think this is a possibility for some of your funds, please read page 110 – Appendix 6: Mapping Funds.

**Reset button**
If needed, the reset button will reset all selected funds back to the UAN defaults in the AFR-Fund Utility. To use it, mark the checkbox next to the desired funds to reset and click [Reset].

If disclosures are required to explain your entity’s classification policies and procedures, the note can be imported using the AFR - Documents Import utility described on page 57.

1 - GOVERNMENTAL FUND CLASSIFICATION TAB

The governmental fund classification tab is only available and required for Governmental funds:

General, Special Revenue, Debt Service, Capital Projects and Permanent

**Note:** If you completed the AFR – Fund Utility last year, any governmental fund classifications and purposes of funds for which you selected a **SINGLE** fund classification and purpose have been carried forward into the 2015 Governmental Fund Classification screen.

However, any fund classifications and purposes of funds for which you selected **MULTIPLE** classifications and/or purposes will NOT carry forward with their cash balances distributed in the 2015 Governmental Fund Classification screen. The reason for this is that fund classifications apply to ending fund **balances**, not to the **funds** themselves. In other words, as ending fund balances change from year to year, any funds with multiple classifications must be redistributed (**i.e. reclassified**) accordingly each year.

At least one classification should be assigned to the fund balance and a purpose must be stated for the balance (in the ‘For’ field). If the entire fund cash balance will fall under one
classification, then click ‘Single’. If the fund cash balance is split between several classifications, then click ‘Multiple’. See the examples below:

**Single:**

![Image of Governmental Fund Classification]

Click the drop down menu to the right to select the classification. **Example 1a:**

![Image of Classification options]

Then in the ‘For’ field, either click the drop down menu to select an existing purpose or type a new one directly into the field, and then click [Save]. **Example 1b:**

![Image of Purpose options]

The classifications labeled ‘Default’ in the Classification menu are those identified by LGS as the most likely classifications based on the use of the resources/revenues. Some funds may have several defaults depending on the range of possibilities for the particular fund. The pre-set purpose options listed in the ‘For’ drop down menu were provided by LGS as typical, and those labeled ‘Default’ were identified as the most likely. However, you may type in a different purpose as needed. **Note:** The software will add any custom purposes to the drop down menu so that they are available to pick quickly for other funds (when applicable).
Multiple:
If you select multiple, the ‘Undistributed’ field lists the fund balance. In the Classification list below, click the drop down menu in the data entry line and select the classification type for the first cash amount to be classified. Then under the ‘For’ column, click the drop down menu in the data entry line to select an existing purpose or type a new one directly into the field. Next, enter the amount to be classified. Click the insert row arrow to push that line up to the list. Continue the steps listed above until the fund cash balance is fully distributed and then click [Save]. Repeat the process for all governmental fund types.

The fund in the example below has a fund balance of $5,310.22 and so far $5,000.00 has been classified. The remaining $310.22 undistributed balance must be classified. Example 2:

![Classification and For example]

2 - OCBOA – FUND INFORMATION TAB

FUND RESTRICTION
For OCBOA reporting, each fund’s balance must be designated either restricted or unrestricted. If the fund balance or a portion of fund balance is restricted, then it must be further designated as capital, debt, or other type of restriction. UAN will display a default restriction type based on how the fund type is normally defined by Local Government Services, but this can be changed based on the entity’s specific use of the fund.

Note: If you completed the AFR – Fund Utility last year, any restriction selections of funds for which you selected a SINGLE restriction type have been carried forward to the 2015 OCBOA – Fund Information screen.

However, any restriction selections of funds for which you selected MULTIPLE restriction types will NOT carry forward to the 2015 OCBOA – Fund Information screen. This is because
restriction types apply to ending fund balances, not to the funds themselves. In other words, as ending fund balances change from year to year, any funds with multiple restriction types must be redistributed accordingly each year.

**Single:**
Select this button when the entire fund balance should be designated as unrestricted or restricted (capital, debt, or other). Then click the drop down menu to the right to select the type. The default type will be listed in the drop down menu.

**Multiple:**
Select this button if the fund balance is split between several types. The calculated column will include the fund balance in the default type. Enter amounts in the override column to distribute the fund balance between the different types until the total fund balance in the calculated and override columns are equal.

**FAQ:** When should a fund balance be designated restricted vs. unrestricted?

Funds should be designated as restricted when constraints placed on the assets use are either imposed through external creditors or imposed by law through constitutional provisions or enabling legislation. Funds should be designated as unrestricted when they do not meet the criteria of a restricted fund. For further information, review AOS Bulletin 2005-002 (see page 32 for the website address).

**Exceptions: Permanent and Fiduciary Funds**
These fund types are automatically identified as restricted and the fund balance must be distributed into non-expendable and expendable portions. To confirm or override the calculated amounts, enter the non-expendable and expendable amounts in the override column. The Total Fund Balance in the override column must equal the amount in the calculated column.

**Note:** The non-expendable amounts in the calculated column for Permanent & Private-Purpose Trust funds are pulled from information entered in the Accounting module. Changing amounts in the override column will only update OCBOA reports, not the fund information in Accounting. To change the non-expendable balance in the Accounting module, follow the steps below:

**STEPS TO ACCESS**
Accounting ➔ Maintenance ➔ Funds; mark the checkbox next to the fund and click [Edit].
Type in the non-expendable amount of the fund in the ‘Non-Exp. Balance’ field and click [Save].
**FUND DETAILS**

Governmental and enterprise funds must be marked as major or non-major for OCBOA financial statements. On several of the OCBOA statements, the funds marked as major will be displayed in individual columns, while the non-major funds will be combined into an ‘other funds’ column.

**Major Fund: Yes or No?**

First, note the system default in the calculated column. You must confirm or change the setting by clicking the drop down menu in the override column and selecting either Yes (it is a major fund) or No (it is not a major fund). The general fund is the exception – it will always be marked as a major fund and the setting cannot be changed. Note that fiduciary funds and internal service funds do not need to be designated as major or non-major, as they are reported separately.

**FAQ 1: How do I determine whether or not a fund is a major fund?**

The default for the fund (the Yes or No in the calculated column) is computed from the fund information and activity inputted throughout the year (see FAQ 2 below). In some cases you might choose to override the default if you have information that is classified incorrectly and/or not reflected in the software. A fund can also be marked as major if government officials believe it is an important fund even though the calculation identifies it as non-major.

**FAQ 2: How does the system calculate the default?**

The calculation is illustrated in the Major Fund Analysis report. To print the report:

**STEPS TO ACCESS**

General ➜ Reports & Statements ➜ Year End ➜ AFR – OCBOA Statements, then select Major Fund Analysis and the system year from the drop down menus.

On this report, three elements of the fund are analyzed (receipts, disbursements, and assets) and the funds are separated into two types (governmental and enterprise).

For a fund to default as a major fund, the individual fund must meet both criteria below:

1. At least one element total (assets, revenues, or expenditures) of that individual fund must be at least 10 percent for the corresponding element total for all funds of that fund’s type (governmental funds or enterprise funds).

2. The same element that met the 10 percent criterion above must be at least 5 percent of the corresponding element total for all governmental and enterprise funds combined.

(i.e. One element must meet both the 10 percent and 5 percent criteria to be considered major.)
FUND ASSETS

This section displays fund assets in terms of how cash & cash equivalents and non-pooled investments are separated for OCBOA statements. The UAN system separates fund assets into two general categories: Equity in Pooled Cash and Cash Equivalents and Investments (non-pooled). Most funds will only consist of these two categories of fund assets. The amounts are calculated based on your transaction and utility input in the normal course of the year and can be easily viewed on the Fund Status report located in Accounting ➔ Maintenance ➔ Fund Reports.

Review to confirm that this is an accurate breakdown of the entity’s fund balance and if needed, make corrections in the Accounting module. For example, perhaps interest earned on a non-pooled investment was supposed to be reinvested, but was posted to the checking account in error. This error would inflate the Equity in Pooled Cash & Cash Equivalents and deflate the Investments (non-pooled) balance, and can be corrected with Accounting transactions or utilities.

OCBOA statements may break down fund assets with two additional categories:

- Cash and Cash Equivalents in Segregated Accounts
  - Example: Mayor’s court at a village – which is kept in a separate account

- Cash and Cash Equivalents with Fiscal/Escrow Agents
  - Example: Monies held and then distributed by another entity on behalf of your entity, such as the county.

  Note: Most funds will not have balances made up of these two categories and many UAN entities do not have any funds that consist of these. However, when applicable, entering amounts in either of the above categories will automatically reduce (distribute) the balance of the fund’s Equity in Pooled Cash and Cash Equivalents for OCBOA purposes.

FUND PURPOSE

Permanent & Fiduciary fund types must be assigned a purpose for OCBOA financial statements. Type a purpose for the fund directly into the Fund Purpose field/drop down menu.

  Note: The software will add the description you entered to the drop down menu so that it is available to pick quickly for other funds (when applicable).
OVERVIEW

Revenues must be classified as either program or general receipts for the Statement of Activities report for all governmental and proprietary funds:

- General
- Special Revenue
- Debt Service
- Capital Projects
- Permanent
- Enterprise
- Internal Service

Note: If you completed AFR – Fund Utility for OCBOA before closing last year, then the program/general receipt type and revenue type selections for the funds you had last year have been carried forward to the 2015 OCBOA – Revenue Programs screen.

Program Receipts

Revenues are to be classified as program receipts if they come from:

- Purchasers, users, or direct beneficiaries of the goods or services of the entity’s programs
- Parties outside the reporting government’s citizenry if the revenue is restricted to a specific program

If classified as program receipts, revenues must be further separated into revenue types:

1. Charges for services and sales
2. Operating grants/contributions
3. Capital grants/contributions

General Receipts

All revenues are classified as general receipts unless they are required to be reported as program receipts. Put specifically, revenues are classified as general receipts if they come from:

- Parties outside the reporting government’s citizenry if the revenue is unrestricted
- The reporting government’s taxpayers
- The governmental institution itself

The decision diagram below illustrates possible classifications for each account code:
It will be helpful to view a draft of the Statement of Activities before using the utility. The list of receipt types is taken directly from this report and the Chart of Accounts.

**STEPS TO ACCESS**

General → Reports & Statements → Year End → AFR – OCBOA Statements, then select the system year and Activities statement from the drop down menu.

For questions concerning these classifications, please contact Local Government Services at 1-800-345-2519.

**USING THE UTILITY**

The revenue list will include all revenue accounts in the fund – both active and inactive codes. Revenue codes with a zero Amount Received balance can be skipped. The software will automatically assign a default classification for most revenues. When a default is selected it will be highlighted in blue font. The defaults may not be correct for every entity, so you should review and make corrections when necessary. Then assign the proper classification for revenues that do not have an automatic default (if any).

**Program / General Receipt Type**

To assign or change, hover the mouse pointer over the field until a drop down arrow appears and click to view the list of options.

**Revenue Type**

It is best to pick the program or general receipt type first before completing this field to avoid inadvertently resetting the revenue type. To assign or change, hover the mouse pointer over the field until a drop down arrow appears and click to view the list of options.
Private-purpose trust and investment trust funds must have revenues and appropriations classified using this utility. The account lists on this screen will include all accounts in the fund — both active and inactive. Accounts with a zero balance in the total column can be skipped.

**Revenue Account List**
Each revenue account balance must be classified as contributions, interest, or a combination of both. To set the classification, hover the mouse pointer over the Receipts field until a drop down arrow appears and click to view a list of options.

- Selecting Contributions or Interest will fill in the total amount under the corresponding column and make the Interest and Contribution fields ‘read-only’.

- Selecting ‘Both’ will enable you to enter amounts in the Interest and Contributions fields for that account. The sum of the two must equal the amount in the Total column.

**Appropriation Account List**
Each appropriation account balance must be classified as Payments in Accordance with Trust Agreements, Other, or a combination of both. To set the classification, hover the mouse pointer over the Disbursements field until a drop down arrow appears and click to view a list of options.

- Selecting Payments in Accordance with Trust Agreements or Other will fill in the total amount under the corresponding column and set the Other and Payments fields ‘read-only’.

- Selecting ‘Both’ will enable you to enter amounts in the Other and Payments fields for that account. The sum of the two must equal the amount in the Total column.
Currently very few entities on UAN use internal service funds. Information about internal service funds is available under Accounting → Maintenance → Funds, then click [Need Help] and scroll to FAQ #10.

This tab enables you to associate receipts in the Internal Service Fund to their related expenditures in other governmental funds. Doing so will eliminate double posting to minimize the grossing up effect on the OCBOA government wide statements (Statement of Activities). The reduction of receipts in the internal service fund must equal the reduction in expenditures in other governmental funds. Reductions are inputted using the following grid lists:

**Governmental Activity list**
This grid will list the disbursements for all funds for the year grouped by appropriation programs. The disbursements column is read only. Expenditures are reduced by entering positive amount(s) in the Adjustment column for the relevant program expenses.

**Revenue Account list**
This grid will list all of the revenue accounts in the internal service fund. The receipts column is read only. Receipts are reduced in the internal service fund by entering positive amount(s) in the Adjustment column for the relevant revenue accounts.
***Skip this section if your entity does not have component units***

Component units usually maintain their own financial information and are generally audited separately from the primary government. UAN entities VERY RARELY have component units. If you are unfamiliar with component units, it is unlikely that it applies to your entity and you can probably skip this step. Before adding a component unit here, contact the State Auditor’s Local Government Services division at 1-800-345-2519 so that they can review the documentation creating a potential Component Unit.

Any component unit must be a legally separate organization with 1) its own legal name, 2) the ability to sue or be sued in its name, and 3) the ability to hold property in its name, with some type of ongoing financial accountability to the primary government entity. GASB Statement 39 and Auditor of State Bulletin 2004-001 both address issues related to component units in detail. You can access the AOS bulletin online by typing this address in your web browser:


The AFR – Component Unit utility provides you with a way to add to your OCBOA statements.

**STEPS TO ACCESS:**
General → Reports & Statements → Year End → AFR – Component Units, then click on the [Add] button to open the form.

Enter the Name of the component unit and complete the form. The information should come from the annual financial report of the affiliated organization. **Note:** the amounts must be entered in whole dollar figures i.e. you cannot enter cents. This information is used on the Statement of Net Position and the Statement of Activities reports.
OPTION #2 FOR STEP 4B
REGULATORY REPORTING

**If filing OCBOA statements, you have completed this utility – return to page 10**

AFR - FUND UTILITY

STEPS TO ACCESS:
General → Reports & Statements → Year End → AFR – Fund Utility

All funds – whether active or inactive – will be listed. Mark (fill-in) the checkbox next to the fund or funds you would like to edit first. Click the [Edit] button and the following drop down menu will open:

Click Regulatory and the Edit AFR – Fund Utility form will open. If multiple funds are selected, the navigation arrows at in the bottom left hand corner of the form can be used.

For example, six funds were selected here: Regulatory. Click the arrows to advance back and forth between funds or move to the first or the last fund selected.

Mapping:
The Mapping section is for miscategorized or ancillary (subsidiary) funds only. The default setting is ‘Not Mapped.’ Most UAN entities will have no need to map any of their funds. When a fund is ‘mapped to’ another fund, it means the current fund’s balance will be considered part of the selected fund’s balance for the purpose of annual financial statements. If you think this is a possibility for some of your funds, please read page 110 – Appendix 6: Mapping Funds.

Reset button
If needed, the reset button will reset all selected funds back to the UAN defaults in the AFR-Fund Utility. To use it, mark the checkbox next to the desired funds to reset and click [Reset].

If disclosures are required to explain your entity’s classification policies and procedures, the note can be imported using the AFR - Documents Import utility described on page 57.
The governmental fund classification tab is only available and required for Governmental funds:

- General
- Special Revenue
- Debt Service
- Capital Projects
- Permanent

**Note:** If you completed the AFR – Fund Utility last year, any governmental fund classifications and purposes of funds for which you selected a **SINGLE** fund classification and purpose have been carried forward into the 2015 Governmental Fund Classification screen.

However, any fund classifications and purposes of funds for which you selected **MULTIPLE** classifications and/or purposes will NOT carry forward with their cash balances distributed in the 2015 Governmental Fund Classification screen. The reason for this is that fund classifications apply to ending fund **balances**, not to the **funds** themselves. In other words, as ending fund balances change from year to year, any funds with multiple classifications must be redistributed (i.e. reclassified) accordingly each year.

At least one classification should be assigned to the fund balance and a purpose must be stated for the balance (in the ‘For’ field). If the entire fund cash balance will fall under one classification, then click ‘Single’. If the fund cash balance is split between several classifications, then click ‘Multiple’. See the examples below:

**Single:**

Click the drop down menu to the right to select the classification. **Example 1a:**

Then in the ‘For’ field, either click the drop down menu to select an existing purpose or type a new one directly into the field, and then click [Save]. **Example 1b:**
The classifications labeled ‘Default’ in the Classification menu are those identified by LGS as the most likely classifications based on the use of the resources/revenues. Some funds may have several defaults depending on the range of possibilities for the particular fund. The pre-set purpose options listed in the ‘For’ drop down menu were provided by LGS as typical, and those labeled ‘Default’ were identified as the most likely. However, you may type in a different purpose as needed. **Note:** The software will add any custom purposes to the drop down menu so that they are available to pick quickly for other funds (when applicable).

**Multiple:**
If you select multiple, the ‘Undistributed’ field lists the fund balance. In the Classification list below, click the drop down menu in the data-entry line and select the classification type for the first cash amount to be classified. Then under the ‘For’ column, click the drop down menu in the data entry line to select an existing purpose or type a new one directly into the field. Next, enter the amount to be classified. Click the insert row arrow to push that line up to the list. Continue the steps listed above until the fund cash balance is fully distributed and then click [Save]. Repeat the process for all governmental fund types.

The fund in the example below has a fund balance of $5,310.22 and so far $5,000.00 has been classified. The remaining $310.22 undistributed balance must be classified. **Example 2:**
2015 Year End Procedures

- Appendices -
APPENDIX 1: TEMPORARY MODE

UAN version 2016.1 (the year end update) includes Temporary Mode. In order to prepare for the use of this feature, please carefully review all of the important information provided in this appendix.

Temporary Mode allows you to work in both fiscal years 2015 and 2016 before closing fiscal year 2015, which provides many potential advantages. Opening Temporary Mode is a required step in the year end process, but working in 2016 before closing 2015 is completely optional. During Temporary Mode, you may select the work year upon login. See below:

This appendix is organized into four parts:
- **Part A** - Advantages of Temporary Mode
- **Part B** - Dating Rules in Temporary Mode
- **Part C** - Accounting in Temporary Mode
- **Part D** - Payroll in Temporary Mode

Important definitions:
- **Fiscal year** - The fund accounting budgetary year
- **Calendar year** - The year of the actual live date / computer date
- **Work year** - The fiscal year you have selected to work in (see picture above)

Please install 2016.1 as soon as you receive it. Note that installing it does not automatically open Temporary Mode or advance your software to 2016.

**PART A - ADVANTAGES OF TEMPORARY MODE**

Temporary Mode is available for sixty days after December 31, 2015 and includes both the accounting and payroll modules. You must manually initiate the opening of Temporary Mode, but it will close automatically when you close 2015.

While the calendar year is still 2015, not only can you continue with your typical day-to-day work for December 2015, you may also log into work year 2016 where you can enter:
- Revenue budgets for fiscal year 2016
- Temporary appropriations for fiscal year 2016
• Purchase Orders that apply to the fiscal year 2016 appropriations
• Payroll maintenance changes (employee setup or withholding rates) that will apply to the first wages posted in January 2016

While the calendar year is 2016, you will be able to perform your typical day-to-day work for 2016, and also log into work year 2015 where you can enter:
• Final 2015 interest receipts from checking accounts or investments
• Any electronic payments made before the end of calendar year 2015
• *Most utility adjustments or other corrections that should apply to fiscal year 2015*
• The December 31st bank reconciliation (after receiving your final bank statement)

PART B – DATING RULES IN TEMPORARY MODE

The rules that have governed post dates throughout 2015 still apply during Temporary Mode:
• Just as before, you can never backdate printed warrants in the UAN software; therefore you cannot print warrants with a 2015 post date after the calendar date has passed December 31, 2015. However, remember that receipts and electronic payments may be backdated to reflect the actual calendar date that online (or phone) transactions were made, in order to be cleared on the correct bank reconciliation.
• Also just as before, you can forward date any payments up to thirty days beyond the calendar date within the work year. Consequently, in order to post transactions in fiscal year 2016, you must be logged into work year 2016.

The only dating restriction specific to Temporary Mode is that 2016 transactions cannot be dated beyond the Temporary Mode period (i.e. sixty days after December 31, 2015). In other words, in order to post transactions dated March 1, 2016 or later, you must first close fiscal year 2015.

Warning! All online or phone payments that you make in calendar year 2016 must be posted in work year 2016; do not improperly backdate such 2016 payments into fiscal year 2015.

PART C - ACCOUNTING IN TEMPORARY MODE

1. Temporary Appropriations
   Be prepared! Your governing board should adopt 2016 temporary appropriations by December 31, 2015 in order to authorize encumbrances and expenditures on and after January 1, 2016. Temporary appropriations should include all expenses you may incur throughout the first quarter of the year. In Temporary Mode, you may enter temporary appropriations for fiscal year 2016 prior to closing fiscal year 2015.

2. Permanent Appropriations
   The new Temporary Mode functionality does not change the proper legal procedures for adopting permanent appropriations. This means that your governing board should adopt permanent appropriations only after:
   A. Fiscal year 2015 has been reconciled and closed
   B. Fund balances and carryover encumbrances have been certified to the county auditor

Revised January 2016  Page 50
C. The Amended Official Certificate of Estimated Resources has been received

After you add your revenue budgets into UAN (verifying that they balance, by fund, with the sum of the Taxes and Other Sources columns on your Amended Certificate), then you can add your permanent appropriations into the software. You must enter revenue budgets before entering the permanent appropriations - otherwise your appropriations will be limited to your unencumbered January 1, 2016 fund balances.

Warning! Do NOT enter permanent appropriations for fiscal year 2016 prematurely, i.e. prior to reconciling and closing fiscal year 2015 (since you would not yet be able to accurately certify your fund balances and carryover encumbrances). If you do enter appropriations prematurely, and subsequently post new payments in fiscal year 2015, you could potentially reduce the resources available for fiscal year 2016 below what you had appropriated. This is a violation of the Ohio Revised Code.

PART D - PAYROLL IN TEMPORARY MODE

1. 2016 Wage Appropriations
   As mentioned previously, you MUST enter 2016 appropriations before you will be able to post any 2016 payments (wages, withholding, or accounting payments). Therefore your governing board must adopt temporary appropriations if you will need to post a 2016 payroll prior to the adoption of permanent appropriations.

2. Payroll Maintenance
   Payroll setup changes that are entered while logged into work year 2015 WILL ALSO update the 2016 setup. For example: if you add a new school tax while logged into work year 2015, that withholding will also be available when you log into work year 2016. However, an important distinction is that maintenance changes entered while logged into work year 2016 WILL NOT apply backwards to 2015. Warning! As always, when updating any employee, be mindful of the effective date of the change; i.e. do not prematurely edit your employee setup. Also be mindful of any changes in tax rates that will apply to the first wages posted in fiscal year 2016 (regardless of the pay period).

3. Calendar Year 2015
   If you open Temporary Mode while the calendar date is still in 2015, you can continue to work in fiscal year 2015 to post wages and withholding payments due to be paid that year. You may also log into work year 2016 to make any necessary changes to employee earnings or withholdings applicable to the first payments to be posted in fiscal year 2016 (and, if required for your payroll schedule, begin posting the first 2016 payments).

4. Calendar Year 2016
   After the calendar date is January 1, 2016 or later, any remaining unpaid 2015 withholdings will carry over for payment in fiscal year 2016. However, you will still be able to log into work year 2015 to post any electronic payments that you paid during calendar year 2015 but neglected to post in UAN at that time. Such items must be posted in work year 2015 in order to be cleared on your December 31 bank reconciliation. Warning! All online or phone
payments that you make in calendar year 2016 must be posted in work year 2016; do not improperly backdate such 2016 payments into fiscal year 2015.

5. **Withholding Liabilities and Reporting** *(Reminder)*
OPERS and OP&FPF reporting and remittance months for wages are determined by *pay period end dates*, while Federal, State, School and Local tax liabilities are instead determined by *paycheck post dates*. Example: Wages with December 2015 pay period end dates posted in January 2016 will be included on the OPERS and/or OP&FPF reports for December 2015, but also correctly recognized as 1st quarter 2016 Federal, State, School & Local tax liabilities.

6. **You cannot do the following in Temporary Mode in the Payroll module:**
   a. Remove or Delete any payroll items in either work year.
   b. Post Wage Reallocations or Wage Adjustments in work year 2016.
   d. Use the Withholding Overpayment utility in work year 2016.

After fiscal year 2015 is closed, these actions will be available again for fiscal year 2016.
APPENDIX 2: YEAR END REPORTS

OVERVIEW

Year end reports may be printed **before or after** closing the year. If you choose to print them before closing the year, **make sure you have completed all transactions, utility adjustments, and posted your final December 31st bank reconciliation.** Otherwise – if any of the activities listed above are completed **after** year end reports have been printed – many of the year end reports will need to be re-printed.

*Important note:* Some year end reporting may require manual type-in or the importing of documents created outside of the UAN software for the year end audit submission file (or disc). You are required to include these in your final year end audit submission before the deadline set by the Auditor of State - financial penalties may be assessed for late filings. These include the two asterisked “*” items below and 4F - AFR Demographics & Debt (page 13) i.e. the Hinkle System.

**Summary of year end reports:**
This list includes all possible year end report requirements
1. **AFR - OCBOA Statements** (Net Position, Activities,…etc.) pg. 55
2. **AFR - Documents Import** (Notes, MD&A) pg. 57
3. **AFR - Regulatory Statements** (Combined & Combining,…etc.) pg. 60
4. **AFR Requiring Manual Input** (Schedule of Debt Service,…etc.) pg. 62
5. **1095 & 1094 Forms** pg. 66
6. **1099-Misc & 1096 Forms** pg. 68
7. **December 31st Year-To-Date Reports** (ledgers, cash journal,…etc.) pg. 70
8. **Payroll End of Year Reports** pg. 71
9. **944 Federal Annual Tax Return** pg. 72
10. **W-2 & W-3 Forms** pg. 73

Entities filing Regulatory annual financial reports can **skip** ‘AFR - OCBOA Statements.’ Entities filing OCBOA annual financial reports can **skip** ‘AFR - Regulatory Statements.’

**Printing prior year reports without exiting the software**
Payroll users: Beginning with fiscal year 2013, prior year reports can be printed without exiting the UAN software. **Accounting-ONLY users have had this ability since fiscal year 2011.** This is possible when logged into Temporary Mode (working in either year) and after closing fiscal year 2015. To print a report from a prior year, open the report area and click on the ‘Year’ drop-down
menu in the upper left corner – all prior years that can be printed from within the current software version will be listed. See the Fund Status example below:

Saving reports in Adobe PDF file format
Year end reports (except for 1099/1096, W-2 and W-3 forms) can be saved as a file in Adobe PDF file format (PDF). To save a report as a PDF file, follow all of the normal steps to print the report except instead of clicking the [Print] button, click the [Save PDF] button located in the lower right hand corner of the report area. This will open a ‘Save As’ window, enabling you to save the file in any directory (i.e. folder). The default directory is C:\_UAN_Efiles.

Other ‘Save As’ Window Options
To save the file to a different folder, click the shortcuts listed on the left pane of the window. Based on your selection on the left, sub-folders will be displayed on the right pane of the window. If needed, continue to open the folders on the right (double-clicking) until you have navigated to the folder of your choice. Another option is to click the arrow to the right of the folder path located at the top of the ‘Save As’ window to open a drop-down menu where you can navigate to recently used folders. To change the file name, type it in the ‘File name’ field.
AFR - OCBOA STATEMENTS

***Those filing the Regulatory annual financial report type should SKIP this section;
It is not required for Regulatory filing ***

It is not necessary to send a paper copy of the AFR to the Auditor of State's Office. The entity’s annual financial report information will be submitted as part of the ‘AFR – AOS Backup’ file (or disc) created for submission when you close the year. However, entities should maintain at least one printed copy of the annual financial reports for public record purposes. It is also recommended that the reports be saved as PDF files for future public records requests.

All OCBOA statements can be accessed in the following area:

STEPS TO ACCESS
General ➔ Reports & Statements ➔ Year End ➔ AFR – OCBOA Statements, then select the year and statement name from the drop-down menus.

Note: by default all amounts listed on AFR statements are rounded to the nearest whole dollar as required by the Auditor of State’s Office. If you would like to print the statements for internal use with amounts rounded to the nearest penny for precise comparison with non-AFR reports, click the “Options” tab and remove the checkmark next to ‘ ☑ Round to whole dollars’.

Print the following OCBOA statements:

<table>
<thead>
<tr>
<th>Abbreviated List Name</th>
<th>Full Statement Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net Position</td>
<td>Statement of Net Position</td>
</tr>
<tr>
<td>Activities</td>
<td>Statement of Activities</td>
</tr>
<tr>
<td>Governmental – Fund Balances</td>
<td>Statement of Assets and Fund Balances – Governmental Funds</td>
</tr>
<tr>
<td>Governmental – Changes</td>
<td>Statement of Receipts, Disbursements and Changes in Fund Balances – Governmental Funds</td>
</tr>
<tr>
<td>Budgetary</td>
<td>Statement of Receipts, Disbursements and Changes in Fund Balance – Budget and Actual – Budget Basis</td>
</tr>
</tbody>
</table>
Additional OCBOA statements for entities with proprietary and/or fiduciary funds:

<table>
<thead>
<tr>
<th>Abbreviated List Name</th>
<th>Full Statement Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proprietary – Net Position</td>
<td>Statement of Fund Net Position – Proprietary Funds</td>
</tr>
<tr>
<td>Proprietary – Changes</td>
<td>Statement of Receipts, Disbursements and Changes in Fund Net Position – Proprietary Funds</td>
</tr>
<tr>
<td>Proprietary – Cash Flow</td>
<td>Statement of Cash Flows – Proprietary Funds</td>
</tr>
<tr>
<td>Fiduciary – Net Position</td>
<td>Statement of Fiduciary Net Position – Fiduciary Funds</td>
</tr>
<tr>
<td>Fiduciary – Changes</td>
<td>Statement of Changes in Fiduciary Net Position – Fiduciary Funds</td>
</tr>
</tbody>
</table>
Some annual financial documents are not created in the UAN software, but must be imported and sent with the audit submission file (or disc) using this utility. **Note:** only Adobe PDF formatted files can be imported.

**All documents applicable to the entity** are required to be included in your final year end audit submission before the deadline set by the Auditor of State - financial penalties may be assessed for late filings.

**Recommendation:** By using Temporary Mode you might gain some extra time to complete these items before closing the fiscal year.

**Entities filing OCBOA**
- Optional: MD&A – Management’s Discussion and Analysis
- Required: Notes – Notes to the Financial Statements
- Rarely required: RSI – Required Supplementary Information – it has been very uncommon for UAN clients to be required to submit RSI documents. UAN provides the import option for those rare instances or for entities that simply choose to file RSI.
- **Other** – UAN has included an ‘Other’ type for any miscellaneous supporting documents that you choose to submit or for any other documents that might be requested by audit.

**Entities filing Regulatory**
- Required: Notes – Notes to the Financial Statements
  Note disclosures are required to explain your government’s fund balance classification policies and procedures.
- **Other** – UAN has included an ‘Other’ type for any miscellaneous supporting documents that you choose to submit or for any other documents that might be requested by audit.

**Additional Resources:**
- Please refer to AOS Bulletin 2015-007 for more information on the submission of Notes. To view the bulletin, type the following address into your web browser: [http://www.ohioauditor.gov/publications/bulletins/2015/007.pdf](http://www.ohioauditor.gov/publications/bulletins/2015/007.pdf)
- Local Government Services provides samples of MD&A and Notes on the AOS website. To access these, type the following address into your web browser: [https://ohioauditor.gov/references/shells.html](https://ohioauditor.gov/references/shells.html). If you are unsure of which notes are applicable for your entity or of the content of the notes to the financial statements, please contact Local Government Services at 1-800-345-2519.

**STEPS TO SAVE WORD / EXCEL FILES TO ADOBE PDF FORMAT:**
The documents import feature is now restricted to files formatted in the Adobe PDF file type per the request of the Auditor of State’s Office so that all files submitted to the Auditor of State will
be a uniform file type. If needed, the steps to save Microsoft Word or Excel files to the Adobe PDF format are included below:

Open the Word or Excel document. Click the ‘File’ menu and click the ‘Save As’ button and a ‘Save As’ window will open (see example below).

![Save As window example](image)

If needed, use the browsing pane on the left to browse to the file folder location in which you would like to save the file (for example, the Documents folder). Confirm or edit the ‘File name’ field. Click the ‘Save as type’ drop down menu and select ‘PDF’. Then click the ‘Save’ button and a PDF file version of your Word / Excel document will be saved to that location. Depending on the computer’s Microsoft default options it may or may not automatically open the PDF after processing. If it does not, click the Window’s start button, type ‘Windows Explorer’ to open the Window’s Explorer file browser and browse to the location that you saved the file to view and confirm it was saved correctly.

**USING THE AFR – DOCUMENTS IMPORT UTILITY**

**STEPS TO ACCESS:**
General → Reports & Statements → Year End → AFR – Document Import

[Add] Click to open the import form.

**Type:**
Click one of the radio buttons ☑ to select the AFR Type to import.
Note: When the ‘Other’ type is selected, a description must be entered.
**File:**
Click [Browse] to open a browsing window to pick the file. If needed, click the ‘Look in’ drop down menu to look through the computer folders for the location of the file. Select the file, then click [Open] to return to the import form. Clicking [Save] will add the file to the AFR – Documents import area, indicating it will be included in the next AOS submission file/disc.

[**Edit**]
This can be used to edit the AFR Type after the document has been imported.

[**Delete**]
Use to delete documents imported in error or that will be replaced by revised documents.

[**Display**]
Display will open the selected PDF file.

**IMPORTANT:**
The purpose of the display button is to verify that the correct information was successfully imported – not to modify the file. To modify the file, you should:
1) Save the revised copy as a PDF file using the software it was created in.
2) Delete the original imported file in the AFR – Documents Import screen.
3) Import the revised copy.
**AFR - REGULATORY STATEMENTS**

***Those filing the OCBOA annual financial reports should SKIP this section; It is not required for OCBOA filing***

It is not necessary to send a paper copy of the AFR to the Auditor of State's Office. The entity’s annual financial report information will be submitted as part of the ‘AFR – AOS Backup’ file (or disc) created for submission when you close the year. However, entities should maintain one printed copy of the annual financial reports for public record purposes. It is also recommended that the reports are saved as PDF files in case of public records requests.

**STEPS TO ACCESS**

All Regulatory statements can be accessed in the following area: General → Reports & Statements → Year End → AFR – Regulatory Statements, then select the year and statement name from the drop-down menus.

**Note:** by default all amounts listed on AFR statements are rounded to the nearest whole dollar as required by the Auditor of State’s Office. If you would like to print the statements for internal use with amounts rounded to the nearest penny for precise comparison with non-AFR reports, click the “Options” tab and remove the checkmark next to ‘☑ Round to whole dollars’.

**Print the following Regulatory statements:**

<table>
<thead>
<tr>
<th>Abbreviated List Name</th>
<th>Full Statement Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Combining Statement – Governmental</td>
<td>Combining Statement of Receipts, Disbursements and Changes in Fund Balances – All Governmental Fund Types</td>
</tr>
<tr>
<td>Combined Statement – Governmental</td>
<td>Combined Statement of Receipts, Disbursements and Changes in Fund Balances – All Governmental Fund Types</td>
</tr>
<tr>
<td>Comparison of Budgeted and Actual Receipts</td>
<td>Comparison of Budgeted and Actual Receipts</td>
</tr>
<tr>
<td>Comparison of Disbursements and Encumbrances</td>
<td>Comparison of Disbursements and Encumbrances with Expenditure Authority</td>
</tr>
<tr>
<td>Reconciliation of Interfund Transactions</td>
<td>Reconciliation of Interfund Transactions</td>
</tr>
</tbody>
</table>
Additional Regulatory statements for entities with proprietary and/or fiduciary funds:

<table>
<thead>
<tr>
<th>Abbreviated List Name</th>
<th>Full Statement Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Combining Statement – Proprietary and Fiduciary</td>
<td>Combining Statement of Receipts, Disbursements and Changes in Fund Balances – All Proprietary and Fiduciary Fund Types</td>
</tr>
<tr>
<td>Combined Statement – Proprietary and Fiduciary</td>
<td>Combining Statement of Receipts, Disbursements and Changes in Fund Balances – All Proprietary and Fiduciary Fund Types</td>
</tr>
</tbody>
</table>
Some annual reports require financial information that is not inputted in the normal course of the year, but must be inputted annually. These reports may include:

- Cash/Other Assets Not Recorded
- Cash Reconciliation
- Schedule of Debt Service
- Schedule of Outstanding Debt

It is possible that none of these reports are applicable to your entity. Skip any that do not apply. However, all applicable reports are required to be included in your final year end audit submission before the deadline set by the Auditor of State - financial penalties may be assessed for late filings.

Recommendation: By using Temporary Mode you might gain some extra time to complete these items before closing the fiscal year.

**STEPS TO ACCESS**

General → Reports & Statements → Year End → All four reports are listed in the menu and each will have options to Print, Display or Save PDF once data is inputted.

### CASH/OTHER ASSETS NOT RECORDED

Does the entity have any cash or other assets that belong to the entity that are not recorded on its books? Some examples of cash not recorded that would be put on this report.

- Money with a financial institution for servicing debt
- Money held in escrow for construction
- Money held by a third party administrator servicing claims for a self-insurance program
- Money held in a deferred compensation program under – 26 USC § 457
- Money held in segregated accounts by other government officials
- Money held by a trustee to satisfy the covenants of a bond indenture
- Money in a payroll clearing account

If necessary, click [Add] to open the form. Enter the account number, institution name, description, and the asset amount. Click [Save] and repeat these steps for all accounts.
CASH RECONCILIATION

This statement compiles information regarding depository balances (checking accounts) and investment information (treasury bonds, certificates of deposit, other investments). You are only required to enter data for this statement if your entity has a bond and coupon clearance account and/or a payroll clearance account not included in the depository balances. Once printed, compare the Fund Status report to the Cash Reconciliation portion of the Annual Financial Report. If there are any differences, contact UAN for assistance in locating the discrepancy.

SCHEDULE OF DEBT SERVICE

This schedule shows the combined outstanding principal and interest of all debt for the years following December 31, 2015. Each year that you enter should show the combined principal and combined interest for all debt to be redeemed in that year. However, you must retain the detailed information with your records for all debt service to maturity, since this information is reviewed during your audit. You should be able to obtain the information required for this debt schedule from the ordinance or resolution authorizing the issuance of debt, bond counsel or your bank.

Click [Add] and starting with 2016, enter the combined principal and combined interest for all outstanding notes and bonds to be redeemed for that year. Click [Save], enter 2017, and then enter the combined principal and combined interest for all outstanding notes and bonds for that year. Repeat this process for five years (or until the maturity of particular debts are reached) and then repeat every five years thereafter (where applicable). See the following example.

**EXAMPLE:** Debt outstanding as of December 31, 2015:

<table>
<thead>
<tr>
<th>Bond # 1</th>
<th>Outstanding Principal</th>
<th>Principal Payment Per Year</th>
<th>Interest Payment Per Year</th>
<th>Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>$10,000.00</td>
<td>$1,000.00</td>
<td>$ 50.00</td>
<td>Ten years</td>
<td></td>
</tr>
<tr>
<td>Note # 1</td>
<td>2,000.00</td>
<td>1,000.00</td>
<td>100.00</td>
<td>Two years</td>
</tr>
<tr>
<td>Note # 2</td>
<td>1,000.00</td>
<td>1,000.00</td>
<td>25.00</td>
<td>One year</td>
</tr>
</tbody>
</table>

Schedule for debt outstanding as of December 31, 2015:

<table>
<thead>
<tr>
<th>Year</th>
<th>2016</th>
</tr>
</thead>
<tbody>
<tr>
<td>Principal</td>
<td>$3,000.00 (Bond #1 + Note #1 + Note #2)</td>
</tr>
<tr>
<td>Interest</td>
<td>175.00 (Bond #1 + Note #1 + Note #2)</td>
</tr>
<tr>
<td>Year</td>
<td>2017</td>
</tr>
<tr>
<td>------</td>
<td>------</td>
</tr>
<tr>
<td>Principal</td>
<td>$2,000.00</td>
</tr>
<tr>
<td>Interest</td>
<td>150.00</td>
</tr>
</tbody>
</table>

**FAQ: Can I enter the same data that I inputted on the Schedule of Debt Service for 2014’s year end reports?**

No, normally you cannot because the amounts will change from year to year. In the reporting year that the Schedule of Debt Service is filled out, the amounts for each projected year are based on the outstanding debt ‘As of’ 12/31/xx (the AFR reporting year). For example, assume at the year end as of 12/31/2014 the combined interest amount scheduled for 2016 was $125 – it is likely that at the year end as of 12/31/2015, this amount will be different.

**SCHEDULE OF OUTSTANDING DEBT**

All outstanding debt activity for 2015 must be described on this schedule with each note or bond described as a separate item. You must retain detailed information with your records for each outstanding debt issue pertaining to 2015, as this information is reviewed during your audit. If necessary, you should be able to obtain the information required for this schedule from the ordinance or resolution authorizing the issuance of debt, bond counsel, or your bank.

Click [Add] and start with the first note or bond to be entered.
Schedule of Outstanding Debt – Examples:

**Example A:** The government had a note issued in 2014 of $6,000.00 issued for a truck. In 2015, the government paid $2,000.00 of debt service on this note. Here is the data that was entered:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Entered</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year Issued:</td>
<td>2014</td>
<td></td>
</tr>
<tr>
<td>Description:</td>
<td>Note issued in 2014 for purchase of truck.</td>
<td></td>
</tr>
<tr>
<td>Interest Rate:</td>
<td>5%</td>
<td></td>
</tr>
<tr>
<td>Balance Jan 1:</td>
<td>$6,000.00</td>
<td>Balance of the note as of 1/1/2015</td>
</tr>
<tr>
<td>Issued:</td>
<td>$ 0.00</td>
<td>No additional amount was issued in 2015, so it is zero.</td>
</tr>
<tr>
<td>Retired</td>
<td>$2,000.00</td>
<td>Amount paid on note in 2015</td>
</tr>
<tr>
<td>Balance Dec 31:</td>
<td>$4,000.00 (Calculated field)</td>
<td>Note balance as of 12/31/2015</td>
</tr>
</tbody>
</table>

**Example B:** In 2015, the same government entity issued a note of $50,000.00 for the construction of a building and paid $10,000.00 of principal on that note. Here is the data entered:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Entered</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year Issued:</td>
<td>2015</td>
<td></td>
</tr>
<tr>
<td>Description:</td>
<td>Note issued in 2015 for construction of a building.</td>
<td></td>
</tr>
<tr>
<td>Interest Rate:</td>
<td>5.5%</td>
<td></td>
</tr>
<tr>
<td>Balance Jan 1:</td>
<td>$ 0.00</td>
<td>Note was issued in 2015, so the 1/1/2015 balance was zero.</td>
</tr>
<tr>
<td>Issued:</td>
<td>$50,000.00</td>
<td>Amount issued in 2015</td>
</tr>
<tr>
<td>Retired</td>
<td>$10,000.00</td>
<td>Amount paid on note in 2015</td>
</tr>
<tr>
<td>Balance Dec 31:</td>
<td>$40,000.00 (Calculated field)</td>
<td>Note balance as of 12/31/2015</td>
</tr>
</tbody>
</table>

*End of section AFR Requiring Manual Input*
The majority of UAN clients may not be required by the IRS to complete the 1095 or 1094 forms, but it is very important that you determine any requirement for your particular entity and comply if necessary. UAN Support can ONLY provide technical software assistance for using the 1095 & 1094 area, but CANNOT provide instructions or advice on whether the form is applicable to your entity or the content entered on the form.

Per the IRS, only Applicable Large Employers (ALEs) and Self-Insured Coverage (SIC) providers must file 1095 and 1094 forms. ALEs are entities with 50 or more full-time employees – including full-time-equivalent (as determined by IRS guidelines) employees. A SIC provider healthcare plan is where the entity is responsible for paying the claims of the healthcare provided to the individuals enrolled in the plan. This does not include plans where the entity pays an insurance company the premiums for the healthcare coverage (i.e. the entity is not responsible for paying for the claims of the individuals enrolled in the plan).

Again, UAN Support CANNOT determine if your entity fits these requirements. For guidance, call the Internal Revenue Service or visit www.irs.gov. You may find the following specific IRS webpages helpful. The first is a special IRS webpage setup to help employers comply with the Affordable Care Act reporting requirements: http://www.irs.gov/Affordable-Care-Act/Employers

Below are IRS instructions for the specific forms:


As you review the above IRS publications, consider the following questions:

- Is your entity an Applicable Large Employer (ALE)? If you are not sure, do you have 50 or more employees? If you do not have 50 or more employees your entity is not ALE. If you have 50 or more employees you will need to use the calculation provided on the IRS website to determine whether or not your entity is an ALE. The IRS calculation website is: http://www.irs.gov/Affordable-Care-Act/Employers/Determining-if-an-Employer-is-an-Applicable-Large-Employer
- Is the insurance your entity offers considered a self-insured plan?

Skip the 1095 & 1094 forms ONLY IF you are confident that – based on the IRS guidance – the entity is not an ALE and does not offer insurance that the IRS considers a self-insured plan.

**STEPS TO ACCESS**

Payroll → Reports & Statements → External Forms → 1095 & 1094 Forms to open the area. If needed, change the year to 2015 in the Year drop down menu.
USING THE 1095 & 1094 FORMS AREA

Because it is likely that only a minority of UAN clients will be required to complete the 1095 & 1094 forms, instructions for using this area of the software are not included in this booklet. UAN will provide software guidance at the annual UAN Update Conference in December – including a handout detailing the Add / Edit / Print button functions used to produce these forms. Approximately a week after the conference, the lecture and handout will be available online.
1099-MISC & 1096 FORMS

STEPS TO ACCESS
General → Reports & Statements → Year End → 1099-Misc & 1096 Forms to open the area. If needed, change the year to 2015 in the Year drop down menu.

[Add] Click to add vendors to the list of those for whom you will print forms 1099-Misc. Read the system message and click [OK] to open the Add form. If needed, filter the vendors by Vendor Type or Payment Total (see below). Then mark the checkboxes next to the vendors to include. Click [Save] to add them to the 1099-Misc & 1096 Forms list. Note: Only one 1099-Misc form may be added per vendor, per selected year. Existing forms may be edited or deleted.

Vendor Type section of the Add form
➊ 1099 Required is the default. When selected the vendors in the list below it will include only those that are marked as ‘1099 Required’ on the Vendor/Payee form. If a required vendor is missing from this list, you can edit the Vendor/Payee information for it at: General → Maintenance → Vendors/Payees, then click [Need Help] for instructions. Please note: You do not need to close the Add 1099-Misc form while editing the vendor. Once you have saved the vendor changes, click [Update Grid] to update this form.

➋ All Vendors: Select this option to list ALL vendors, regardless of whether they are marked ‘1099 Required’ on the Vendors/Payees form.

Payment Total section of the Add form
➊ At Least: You can filter the vendor list by the total dollar amount of payments per vendor that year. Select this button and then type in the dollar amount. Then click [Update Grid].
➋ Any Amount (Default): This will display all vendors based on the Vendor Type filter selected (see above). After making any filter changes, click [Update Grid] to update the list.

[Edit] Use to override any default vendor information relevant to the 1099-Misc form. Sections of the Edit 1099-Misc form are described below:

Vendor Section of the Edit form
Location drop-down menu: If the vendor has multiple addresses, you can change the address that will print on the 1099 form by selecting it from the Location drop-down menu.
➋ Print Name & Address: Saved (default). This setting brings data into the form from General → Maintenance → Vendor / Payees.
➋ Print Name & Address: Override can be used when needed to override the data.
Other section of the Edit form
☐ Mark as Corrected and ☐ Mark as 2nd TIN not. Marking either of these checkboxes will fill in the corresponding box on the 1099-Misc.

ID & Account # section of the Edit form
Print ID & Account #: Saved (default). This setting brings data into the form from General → Maintenance → Vendor / Payees.
Print ID & Account #: Override can be used when needed to override the data.

Note: edits will update the 1099-Misc form, but will not update the Vendor/Payee information permanently. When possible, it is better to make an edit in the software area that the data is being pulled from (such as General → Maintenance → Vendor/Payees), delete the 1099-Misc form and then add it again. However, some edits can only be made on the form itself. For example, vendor names cannot be edited in the Vendor/Payees area after a purchase order or payment has been posted to the vendor. Also, if a payment error is discovered after the close of the fiscal year in which it was posted, the correction will not update in that fiscal year’s reports, but it can be fixed on the 1099-Misc form.

Amounts section of the Edit form
Print Amounts: Calculated (default). Box 7 is the only field listed that will pull in calculated data from the software. It will include the amount of all payments posted to the vendor in UAN for the year. All other boxes are blank by default.
Print Amounts: Override can be used when it is necessary to override Box 7 and/or to enter amounts in other boxes. UAN cannot advise on whether it is applicable for your entity to enter amounts the other boxes or the amount to distribute. Please review IRS instructions https://www.irs.gov/pub/irs-pdf/i1099msc.pdf or if needed, contact the IRS or a tax advisor.

Other buttons below the 1099-Misc & 1096 Forms area:
[Delete] Click to delete vendors that were added to the list in error or that will be replaced.
[Print 1099] Click to print the marked vendors. Make sure to load blank 1099-Misc forms.
[Print 1096] Click to print the marked vendors. Make sure to load a blank 1096 form.
DECEMBER 31ST YEAR-TO-DATE REPORTS

Print and/or save PDF files of the reports listed below that include the entire year’s activity (January 1, 2015 – December 31, 2015). Regardless of what was printed for each month, the AOS audit division recommends that entities retain either paper or PDF year-to-date reports. Monthly reports are acceptable only if you have printed or saved them each and every month.

Suggested reports are below. Select the report from the drop down menu and then 2015. The report date range must be set to either ‘Year’ or ‘As of’ 12/31/2015, depending on the report.

<table>
<thead>
<tr>
<th>Report</th>
<th>Steps to Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appropriation Ledger</td>
<td>Accounting → Reports &amp; Statements → Appropriation Reports</td>
</tr>
<tr>
<td>Appropriation Status</td>
<td></td>
</tr>
<tr>
<td>Bank Reconciliation Report</td>
<td>Accounting → Reports &amp; Statements → Bank Reconciliation Reports</td>
</tr>
<tr>
<td>Cash Journal</td>
<td>Accounting → Reports &amp; Statements → Cash Reports</td>
</tr>
<tr>
<td>Fund Balance Adjustment Listing</td>
<td>Accounting → Reports &amp; Statements → Fund Balance Adjustment Reports</td>
</tr>
<tr>
<td>Cash Summary by Fund Fund Status</td>
<td>Accounting → Reports &amp; Statements → Fund Reports</td>
</tr>
<tr>
<td>Interfund Advance Listing</td>
<td>Accounting → Reports &amp; Statements → Interfund Advance Reports</td>
</tr>
<tr>
<td>Interfund Transfer Listing</td>
<td>Accounting → Reports &amp; Statements → Interfund Transfer Reports</td>
</tr>
<tr>
<td>Investment Journal</td>
<td>Accounting → Reports &amp; Statements → Investment Reports</td>
</tr>
<tr>
<td>Purchase Order Status</td>
<td>Accounting → Reports &amp; Statements → Purchase Order Reports</td>
</tr>
<tr>
<td>Receipt Listing (sorted by deposit ticket number, then receipt number). This report is useful if you entered deposit ticket numbers for your receipts. If not, it can be skipped.</td>
<td>Accounting → Reports &amp; Statements → Receipt Reports</td>
</tr>
<tr>
<td>After selecting Receipt Listing, click the Sorting tab, then select ‘Deposit Ticket then Receipt Number’.</td>
<td></td>
</tr>
<tr>
<td>Revenue Ledger</td>
<td>Accounting → Reports &amp; Statements → Revenue Reports</td>
</tr>
<tr>
<td>Revenue Status</td>
<td></td>
</tr>
<tr>
<td>Vendor / Payee Receipt Register</td>
<td>General → Reports &amp; Statements → Vendor / Payee Reports</td>
</tr>
<tr>
<td>Vendor / Payee Payment Register</td>
<td></td>
</tr>
</tbody>
</table>

Revised January 2016
PAYROLL END OF YEAR REPORTS

UAN does not provide a list of payroll reports to print at year end, although you may want to select some reports to Print or PDF for the year. The payroll reports you will have to present at your next audit include the forms W-2 and W-3, all monthly and/or quarterly tax and retirement reports you have filed, and the payments corresponding to these reports. You should have physical copies of these reports for your next audit. If you didn’t keep physical copies of reports filed, gather that information now. Note that the UAN software will generate reports that indicate what you should have reported, but it may not reflect what you actually filed.

Often the December and/or 4th Quarter reports are forgotten in the busy rush of closing the year. Remember that you must file the December OPERS/OP&FPF Retirement reports after you have posted the final wages for pay periods ending in December. You must also file Federal, State and Local tax reports for the month and/or quarter, and the 4th quarter ODJFS (Ohio Department of Job & Family Services) Wage Detail after you have posted all wages with December post dates. You must print the W-2 and W-3 forms, and submit them per IRS instructions to the employees and the Social Security Administration.

State, School and Local taxes many times require you to file an annual report that compiles all wages and withholdings for the year to submit with or in addition to the forms W-2. It is your responsibility to contact these agencies to determine the forms you need and the deadlines to file. Reports you may want to print to complete these reports:

UAN no longer produces the rarely-used Form 944 Federal Annual Tax Return.

You must file annual Form 944 instead of filing quarterly Forms 941 ONLY if the IRS notified you in writing. Form 944 is designed so the smallest employers will file and pay federal taxes only once a year instead of every quarter. For all questions about which forms your entity should file, contact the IRS or visit http://www.irs.gov.

Information for completing a 944 form is available on the 2 federal tax reports listed below* (using the “Year” date selection) in: Payroll → Reports & Statements → Tax Reports – Federal. The “YTD Total” rows show the corresponding totals for the 944.

<table>
<thead>
<tr>
<th>944 Form</th>
<th>* Federal Tax Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wages, tips, other compensation</td>
<td>Wages Subject to Federal / State / School Tax YTD</td>
</tr>
<tr>
<td>Taxable social security wages (Column 1)</td>
<td>Wages Subject to Social Security Tax YTD</td>
</tr>
<tr>
<td>Taxable Medicare wages &amp; tips (Column 1)</td>
<td>Wages Subject to Medicare Tax YTD</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>944 Form</th>
<th>* 941 Schedule B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Federal income tax withheld...</td>
<td>Federal YTD + Federal Supplemental YTD</td>
</tr>
<tr>
<td>Monthly tax liability (only if required)</td>
<td>Total for each month in Total column</td>
</tr>
</tbody>
</table>

Everything else on the 944 form is calculated from these figures. Total deposits for the year are available on the Vendor Payment Register: General → Reports & Statements → Vendor / Payee Reports (for the federal payee).
VERIFY TAX IDS, WITHHOLDING & EMPLOYEE INFORMATION

Before December 31, 2015 you should verify the basic information that will print on the W-2s. Any edits to employees made in 2015, such as address changes, will also update the employee information in 2016. On the other hand, edits made to employees in 2016 will not appear on 2015 W-2s – requiring you to manually edit the address on the W-2 forms.

Entity Information:

Steps To Access: General → Maintenance → Entity Setup, verify or correct the Federal and State Tax IDs and the entity address.

Withholding W-2 Local Tax Abbreviations and School District numbers:

Steps To Access: Payroll → Maintenance → Withholdings, select all Local and School tax withholdings, and click Edit. Verify that the W-2 Abbreviation is correct for all Local Taxes and the School District # is correct for all school district income taxes.

Employee Information:

Steps To Access: Payroll → Maintenance → Employees, select all employees, click Edit and Advanced. On the Employee Information Tab, verify the name, address and Social Security number. If your employees have moved or changed a name during the year, these updates must be made before you close 2015. After making any necessary changes, click Save to advance to the next employee record. When no changes are necessary, the navigation arrows at the bottom left hand corner of the form can be used to advance to the next record e.g.
WHEN SHOULD I PRINT MY W-2 FORMS?

Before printing W-2 forms, it is recommended that you complete the steps below to ensure your year to date tax reports balance with the total forms W-2. It is likely you will close fiscal year 2015 before you are ready to do this. Only entities that have no housekeeping items to resolve and have a payroll schedule allowing them to complete their payroll postings, tax payments, and withholding reports in December will be able to generate W-2 forms before 2015 is closed.

1) Research, identify and resolve all 2015* unpaid withholdings and/or withholding overpayments that would affect the 2015 monthly/quarterly tax reports and W-2s.
   *Unpaid withholdings and withholding overpayments carried forward from before 2015 will not affect the 2015 W-2 forms, but will affect your 2016 budget.
2) Finish posting all 2015 Wages.
3) Prepare December and/or 4th Quarter tax reports.
4) Pay 2015 tax liabilities (either in 2015 or in 2016, if carried over).
5) It is recommended, but not required, to wait until you have completed your December Bank reconciliation. Until you have posted the final bank reconciliation, you may need to make changes that affect the monthly and/or quarterly tax reports, payments, and W-2s.

If this is the first time you have prepared W-2s in UAN, or you had a 2015 payroll situation that may require extra scrutiny, refer to the Pre-W-2 Payroll Review on page 87 for more details.

ADD & EDIT W-2 FORMS

You can Add, Edit and Print the 2015 W-2s while you are logged into 2015 or 2016, before you close 2015 or after you close 2015. You no longer have to exit the software to access prior year (2015) reports. Follow the steps to access then select 2015 from the year drop down list. Note that you must start the process with Add.

Steps To Access: Payroll → Reports & Statements → External Forms → W-2 and W-3 Forms, the W-2 & W-3 Forms tab will open. (Once you have added the Employees, they will appear and remain in the list for you to select.) The upper part of the form requires you to make choices before you click Add; see below:
It is important to set the year to the correct W-2 fiscal year prior to clicking the Add button. Notice the symbol to the right of the word Add on the button and the instructions below indicating you must select the year before clicking Add. If you are working in fiscal year 2015 the year 2015 will default in the box. If you are working in fiscal year 2016, and you have posted wages in 2016, the year 2016 will default in the box. To select the correct fiscal year, click the drop down arrow and select the year. It will then appear in the box as you see above.

Click the Add button. You will receive the following system message:

The message is informative and self-explanatory. After you Add a W-2 for an employee you must delete that W-2 if you wish to start over and Add a new W-2 for the same employee. You will be able to manually edit the W-2s. However, the W-2 report will not reflect manual edits; it will only report the data from the actual payroll postings. Click OK to continue.

The Add W-2 Form opens and the upper left corner defaults to employees “Paid This Year (Any Status)” as seen below. W-2s will be prepared for all Active and Inactive employees that were paid in fiscal year 2015. This default setting is recommended unless you need a W-2 for an employee that was not paid in fiscal year 2015. (2015 new UAN clients that have added all of their employees to the payroll software but did not post wages for all employees in the software may want to select All Employees so you can create a W-2 to edit. Even if they don’t have any posted wages in UAN, you can use the software to create and edit a W-2)

Select all employees by clicking the header check box, or select only the employees you want to prepare at this time. If you select individually, do not forget to go back and Add the others (the software will not warn you if you have forgotten someone!). When you have selected the employees, click Save. You should see a confirmation in the lower left corner. Click Close. The
list will populate with the employee W-2 forms that you have added. To Edit an employee form, select the employee and click Edit. You will receive the following System Message:

After you carefully read the system message click OK and the Edit W-2 Form will open. See the picture below to familiarize yourself with the form areas and tabbed pages. At the top left of the form you will see the W-2 Year and the Employee ID. Areas of the form that cannot be edited have instructions that will display the path to edit those items. These areas are emphasized in the picture that follows with a circle and emphasized with red letters on the actual form on your screen. Areas that may require you to update the information elsewhere are:

- Employee’s Social Security Number and Address:
  Edit in Payroll → Maintenance → Employees

- Employer Name, Address and Federal Tax ID:
  Edit in General → Maintenance → Entity Setup

If you need to make changes to these areas, (save the W-2 form if you made changes thus far) close the W-2 form and follow the path to make the necessary changes. The next time you open the W-2 Edit form, the updated information will appear.

Each area of the form that can be edited contains a radio button labeled Override. In the picture that follows, you see the areas that have an override option: Print Name, Box 13, and Print Federal. To make changes in these areas, select the Override radio button and edit the items you wish to change in the override area; the calculated data remains unchanged so you can see the current UAN data. Selecting Override on the Federal tab will duplicate the calculated amounts into the override boxes. Type over any amounts in the Override column that you need to change.
On the State & Box 12 tab page there is a Print State: Override and Print Box 12: Override. When selecting Override, the original data is duplicated into the override area. You can edit the existing override lines, delete lines by clicking the X, or use the data entry line to add new lines:

On the Local & Box 14 tabbed page there is a Print Local: Override and Print Box 14: Override. Selecting Override will duplicate the calculated amounts into the override area. You can edit the existing override lines, delete lines by clicking the X, or use the data entry line to add new lines:
Click Save when you have finished editing. Click Close to close the Edit W-2 form. When you have completed the review of all W-2s, remain on the W-2 and W-3 forms to print. If you have edited wages and/or withholdings or other items, be sure to perform a final check to make sure the W-3 generated by the edited W-2s balance with your year to date tax report totals.

**PRINT W-2 & W-3 FORMS**

**UAN will only print these forms on plain blank paper.** This prevents various printer alignment issues that many entities had encountered with pre-printed forms. If you wish to print forms W-2 on perforated paper, perforated plain blank paper may be purchased from many vendors who also offer the pre-printed forms.

The perforated plain blank paper styles compliant with the UAN software are the 2-Part (2-up) sheets with one horizontal perforation (2 forms per sheet), and the 4-Part (4-up) sheets with three horizontal perforations (4 forms per sheet). **W-2 and W-3 forms in UAN meet 2015 Social Security Administration (SSA) plain paper printing requirements.** UAN provides the following plain blank paper W-2 printing options:
Select Type

Steps To Access: Payroll → Reports & Statements → External Forms → W-2 and W-3 Forms. Make sure 2015 is in the Year box. Employers with both social security and OPERS or OP&FPF employees must print forms W-2 and the corresponding W-3s in two batches; one for the social security (941/944) employees and another for the OPERS and/or OP&FPF (MQGE) employees.

Entity that have registered with the SSA to upload an electronic W-2 and W-3 file must follow these instructions to print the State and Local Employer and all Employee forms, but do not need to print the Federal Employer copy A. You may want to print the W-3 from the UAN software so you will have a copy on hand. Instructions to create the electronic W-2 and W-3 file is outlined in detail at the end of the W-2 and W-3 printing instructions.
You should remain on the Print W-2 page until all copies for this group of employees has been printed. The first group of W-2s to be sent to the printer will take longer to process because the software will create the calculations that all the Employer and Employee forms use for printing this group. As long as you remain on this page the calculations will remain available throughout the printing process, making the printing of other selections much quicker. If you exit the form before completing the printing of all the forms, the software will recalculate the next time you open the form again, slowing down that print session.

At the bottom of the form, you may select to print the W-2s in order by Name or SSN. You do not have to use the same setting for all form types. For any employees whose withholding information cannot fit onto a single W-2, extra copies will print automatically (omitting certain redundant information, as specified by the form instructions).

If you have State, School and/or multiple local taxes you will need to print a Copy 1 to submit to each tax district as required by your withholdings. If you file a monthly or quarterly report for school or local taxes then you will be required to submit an annual reporting form (you must contact the tax districts to obtain their forms) with Copy 1. UAN will not instruct you further on this matter, you must contact the tax districts to understand their filing requirements and obtain their annual forms to accompany the W-2.
1) Make your first selection by clicking the radio button for your choice, select to order the employees by Name or SSN, verify you have the correct paper in the tray, and click OK.

2) After the forms have printed, make your next selection, select to order the employees by Name or SSN, verify you have the correct paper in the tray, and click OK. Repeat these steps until you have printed all Employer and Employee sets you need, then click Close.

3) W-3: It is recommended you print the corresponding W-3 form for the first group of employees before printing W-2s for the next group. Select all the employees in the list without changing the Type and click Print W-3. You will receive a System Message.
Read the message and click OK. The Print W-3 form will open. Areas emphasized below with an arrow appear on the form as entered in Entity Setup. Verify these items are correct. If you need to correct these items, click close. **Steps To Access:** General → Maintenance → Entity Setup. Correct the data, save and close, and return to the Print W-3 Form. **Steps To Access:** Payroll → Reports & Statements → External Forms → W-2 and W-3 Forms. Set the Type to the same type for the W-2s you printed, select the employees, and click Print W-3.
Areas that must be completed by you are listed below:

1) Select your Federal Tax Report type: 941 Quarterly or 944 Annual (if available).

2) Select your Kind of Employer: State/local non-501c or State/local 501c. Click the blue question mark for more information. UAN cannot help you with this selection, if you don’t know the correct selection, you must contact the IRS for assistance.

3) The total number of W-2 forms for this W-3 will automatically calculate. Some employees may generate more than one W-2 Form. Only edit this if necessary, using the override box.

4) In the 941/944 Employees tabbed area the only box you can change is box 14. If you have Income tax withheld by a payer of third-party sick pay enter the total in this box. UAN Support cannot answer questions about third-party sick pay.

When you have completed the above selections click OK. The print form opens, select the printer and click Print. You will receive the following system message:

![System Message]

Read the message. Only you will know if you completed the verifications or made necessary corrections as outlined above. The tax districts will use your year to date tax deposits and/or reports to compare the W-2s for accuracy. If the W-2 doesn’t balance with the reports and taxes you have paid you will be contacted to explain the discrepancy.

Click OK. You will return to the Print W-3 form. Click Cancel to return to the W-2 & W-3 Forms main page. Follow the steps starting on page 79 to print the W-2 forms for the second Type (941/944 or MQGE) of W-2 and the corresponding W-3 form. Afterward, remain on the W-2 & W-3 form to print the Notice to Employees.

**Note:** Per IRS rules, boxes 16 and 18 are totals of all boxes 16 and 18 from the compiled W-2s. For example, if you have just one employee with $50,000 of wages subject to a city tax and the same $50,000 also subject to a school tax, they are reported separately on the W-2 (2 lines 18 of $50,000 each), but are combined into the single line 18 on the W-3 with a total of $100,000.
PRINT NOTICE TO EMPLOYEES – REQUIRED

All W-2s issued on blank paper must be accompanied by a Notice to Employee. You can print the Notice to Employee from the W-2 & W-3 Forms page.

Steps To Access: Payroll → Reports & Statements → External Forms → W-2 and W-3 Forms, the W-2 & W-3 Forms tab will open. Click the Print Notice button (as seen below) and the Print form will open. On the Print form, select the number of copies you need, and click Print.

CREATE ELECTRONIC FILE FOR UPLOAD TO SSA – OPTIONAL

If you have registered with the SSA to upload your W-2s and W-3s as electronic files you will be ready to complete this once you have printed the W-2s and W-3s and verified their accuracy.

Steps To Access: Payroll → Reports & Statements → External Forms → W-2 and W-3 Forms, the W-2 & W-3 Forms tab will open. Select Year 2015 and Select Type All.

Select all of the employees in the list and click File. You will receive the following message:

Read the message and click OK. The File W-2 and W-3 form opens. You must complete the areas outlined below:

1) Select your Federal Tax Report type: 941 Quarterly or 944 Annual

2) Select your Kind of Employer: State/local non-501c or State/local 501c. Click the blue question mark (?) for more information. UAN cannot help you with this selection, if you don’t know the correct selection, you must contact the IRS for assistance.
3) You must enter your BSO User ID in the box *(emphasized below with a circle and an arrow)*. UAN cannot assist you with this number; you must register with the SSA in order to file electronically. Contact the SSA if you have any questions about this.

4) The entity email address and telephone number are required to create the electronic file; you can enter or edit these items on the form.

5) In the 941/944 Employees tabbed area the only box you can change is box 14. If you have Income tax withheld by a payer of third-party sick pay enter the total in this box. UAN Support cannot answer questions about third-party sick pay.

6) In the MQGE Employees tabbed area the only box you can change is box 14. If you have Income tax withheld by a payer of third-party sick pay enter the total in this box. UAN Support cannot answer questions about third-party sick pay.
**Note:** Per IRS rules, boxes 16 and 18 are totals of all boxes 16 and 18 from the compiled W-2s. For example, if you have just one employee with $50,000 of wages subject to a city tax and the same $50,000 also subject to a school tax, they are reported separately on the W-2 (2 lines 18 of $50,000 each), but are combined into the single line 18 on the W-3 with a total of $100,000.

After completing the necessary entries, click OK. You will see the following System Message:

![System Message](image)

It is recommended you print this report. Once the report prints you will receive a second system message showing you the electronic file “W2 Upload 2015.txt” has saved successfully and the location of the document on your C (local) drive.

![System Message](image)

The electronic file is ready for upload to the SSA. You do not have to mail forms W-2 and W-3 to the SSA if you submit the electronic file. If you have difficulties with the upload process, you **must** contact the SSA for assistance.
PRE-W-2 PAYROLL REVIEW

Follow the 3 steps below to determine if you are ready to begin W-2 preparation and printing:

1) Confirm that you have paid all of your 2015 taxes. Print and review the Withholding Summary for 2015, and if you had any 2015 carryover withholdings that were paid in 2016, print the report for 2016. The year selected for the report is critical to its interpretation – any withholdings carried over and paid in 2016 will always be considered unpaid on the 2015 report. Please also note that W-2s report withheld amounts for all payrolls dated within the year, regardless of whether they have been remitted to the withholding agencies yet.

Steps To Access: Payroll → Reports & Statements → Withholding Report. The Withholding Summary defaults as the first report on the drop down list. If you have opened Temporary Mode you can select the year from the drop down box; you do not have to exit the software and log into a different year. If there are no unpaid withholdings you will receive a system message stating there is no data to report. If you have both types of withholdings, Regular and State Retirement, remember to print the report with the proper settings. Select Original Post Date for Regular withholdings and select Pay Period End Date for State Retirement withholdings. These two items cannot be used properly with the same date setting.

You may have January 2016 unpaid withholdings if you have posted wages in 2016, but they are not relevant to the taxes reported on the 2015 W-2s. Only the Prior Year Withholdings column on the 2016 report will be relevant to confirm your 2015 taxes have been paid. If you have carryover withholdings from prior to 2015, you should return to the Payroll Housekeeping section of the Housekeeping Manual to research and resolve those items prior to closing fiscal year 2015. Carryover items of this type will negatively impact your new year budget. You will have to determine if the 2016 Prior Year Withholdings column contains any 2015 unpaid withholdings.

If there are unpaid withholdings from wages posted in fiscal year 2015 on either the Withholding Summary for fiscal year 2015 (January thru December columns) or fiscal year 2016 (only the Prior Year Withholdings column) you will need to identify why those haven’t been paid to determine if you need to:

- Amend tax reports and issue another payment,
- Clear the unpaid withholding because it was already paid in Accounting, and/or
- Edit the W-2 to manually resolve a problem that wasn’t corrected before fiscal year 2015 was closed.
2) Print the W-2 report and compare the Report Totals to your file copies of the 2015 tax reports for Federal, State, School, and Local taxes to confirm that you have reported and paid the amounts that will be reported on the W-2s.

Steps To Access: Payroll → Reports & Statements → Tax Reports – Federal. From the drop-down list select the W-2 Report. Select all employees listed and click Print. Use the last page(s) that contain Report Totals to compare with the tax reports you have filed with Federal, State, School, and Local tax districts for the year. Use the employee pages for review in 3) below.

Compare each tax district/type separately; add the monthly or quarterly reports for 2015 together to arrive at the total you have reported and paid to each district in 2015. You should not print the report from UAN; reports printed from the UAN software at this time will generate the same amounts used on the W-2. Review copies of the reports you filed during the year; you should have paper copies, or if you report online you may be able to go to the taxing district website and print copies of the reports you filed and the list of payments you made. (You should have retained copies of these reports for your next audit.)

- If you have multiple local and school taxes you may find it helpful to print the UAN Local Tax and School Tax reports for the year as they will break down the totals by tax district so you can understand the total Local and School taxes on the W-2 Report. Do not use these UAN printed reports to verify the W-2 report is correct; they use the same data and will match exactly. Compare the UAN reports to the actual reports filed and payments made for each tax district.

Steps To Access: Payroll → Reports & Statements → Tax Reports – Other, from the drop-down list select the report you need, Local tax and/or School tax, mark the report for the year and print. Repeat for each report you need on the drop-down list.

If you haven’t had any payroll issues in 2015 you will be able to easily confirm that the amount reported and paid for 2015 balances with the total you will report on the W-2s.

You may discover discrepancies if you have had issues with your payroll, such as posting wages with the incorrect retirement (Social Security, OPERS or OP&FPF) or improperly voiding or not voiding payroll checks. If you corrected these items in the software but failed to amend your reports and payments, identify the errors and make proper amendments so your reports balance with your W-2 forms.

The UAN software correctly identifies tax liabilities for reporting and payment by the paycheck post date. If you have improperly reported and paid your taxes by the payroll pay period date and you manually prepared the tax reports in this manner, you may have made errors and the W-2s
may not balance with your year to date tax reports. You must find your reporting errors and amend the reports so they balance with the 2015 wages that will be reported on the 2015 W-2s.

- **Important!** – It is normal and correct for the OPERS/OP&FPF amounts reported on the W-2 to differ from the totals reported to OPERS or OP&FPF for the year. The W-2 is a tax report, **NOT** a retirement report! Tax reports **very rarely** correlate to state retirement reports, as tax reports reflect withholdings by paycheck date (**regardless of pay period**) while OPERS and OP&FPF reports are based on pay periods (**regardless of paycheck date**). In other words, do not edit the W-2 amounts to match OPERS or OP&FPF reports!

For example: wages that were posted in January 2015 for pay periods that ended in December 2014 would have been reported to OPERS/OP&FPF for December 2014, but would **NOT** have been reported on the 2014 W-2 – instead, they will be reported on the 2015 W-2. Likewise, wages that will be posted in January 2016 for pay periods ending in December 2015 will be reported to OPERS/OP&FPF for December 2015, but will **NOT** be reported on the 2015 W-2 – instead, they will be reported on the 2016 W-2.

To view the employee wages with OPERS/OP&FPF withholdings that are included on the W-2, view the Wage Withholdings Detail.

**Steps To Access:** Payroll → Reports & Statements → Wage Reports, select Wage Withholdings Detail, select year and mark the employees. You will be able to review, by employee, the wages and withholdings from all the 2015 paychecks as they will be reported on the W-2.

If you have had difficulty with OPERS/OP&FPF reports and payments throughout the year, you may want to review the Wage Withholding Summary using the Pay period End Date setting.

**Steps To Access:** Payroll → Reports & Statements → Wage Withholding Summary, change the Original Post Date setting to Pay Period End Date, select each month and mark the employees and compare the data to the reports you have filed with OPERS/OP&FPF.

**Note:** The W-2 report only reflects the employee share of Medicare and Social Security, not the combined employee and employer share that you report on the 941. To compare Medicare and Social Security from the W-2 report to the total on the 941 quarterly reports, take the Report Total of each item from the W-2 Report and multiply by 2 to arrive at the combined total amount that should have been reported on the 941 quarterly reports. If you had fractions of cents adjustments, those adjustments should bring the items into balance with the W-2 report.

- If you were required to swap 2015 withholdings between Social Security and a State Retirement (OPERS/OP&FPF) you must review the employee W-2 Reports to see if you
must manually edit the W-2. The swapped withholding amounts will be accurate for the Social Security tax withheld and in Box 14 as OPERS or OP&FPF; however, you may need to adjust the amount of Social Security wages. *Changes to prior year earnings and withholdings that were swapped between retirement types do not affect 2015 W-2s.*

When a Payroll Wage Adjustment Withholding Swap is posted between Social Security and a State Retirement, a corresponding Earning Swap should be posted. However, when the earnings being swapped were paid in different quarters and the post date of the swap will corrupt a new tax quarter, UAN Support does not recommend posting a corresponding Earning Swap, but advises the client to manually edit the affected 941(s) and to make notes to manually edit the W-2s. If you were required to manually adjust the Social Security wages on 941s and you did not post a corresponding Earning Swap, you must also manually override the Social Security wages on the W-2 for the affected employees. If you are uncertain if you posted an Earning Swap, review the posted Wage Adjustments:

**Steps To Access:** Payroll → Utilities → Wage Adjustments mark the listed Wage Adjustments, click Display. Review the details of the adjustments. Withholdings Swaps between Social Security and a State Retirement require a corresponding Earning Swap for the W-2s to be accurate. If a corresponding Earning Swap is not listed you must manually override the Social Security wages on the W-2.

- If you did not use the Wage Adjustment Utility to correct the allocation of wages between Social Security and a State Retirement (OPERS/OP&FPF) and you manually edited your quarterly 941(s) and made payments from the Accounting software, you must manually override the W-2 to correct Social Security wages, the Social Security tax withheld, and the State Retirement in Box 14. Instructions how to edit the W-2 in the UAN software are contained in the Edit W-2 section below; however UAN will not tell you how to arrive at the correct amounts. You must determine the correct amounts and areas that must be manually edited on the W-2s to match the edits you made to the tax and retirement reports.

**Note:** When you manually edit the W-2s, the W-2 Report will not reflect the changes. Only the W-2s and the corresponding W-3 will reflect the manual edits. If you had to edit the W-2s, it is recommended that you verify the quarterly 941 reports and your state and local tax reports totals balance with the corresponding W-3 report before issuing W-2s to employees.

The taxing districts will compare your W-2s with the reports you have filed and payments you have made for 2015. If there is a discrepancy, they will require you to reconcile the items; it is therefore recommended that you reconcile and correct any errors before issuing the W-2s.

3) Review the Employee pages of the W-2 report (printed earlier in step 2).

- If you didn’t have any housekeeping problems or OPERS and SS swap issues but you are having difficulty reconciling the Base Wages on the W-2 Report (or on the W-2 Boxes 1,
3 and 5), you may not be taking into consideration the correct taxing and reporting of Cafeteria Plans, Deferred Compensation, fringe benefits, and/or salary reductions. You must understand the rules that govern these items to properly reconcile. The portion of total earnings against which a withholding is calculated (its “wage base”) varies by withholding type. Withholding wage bases may exclude specific earnings or be reduced by other withholdings. If your question is “Is my Cafeteria Plan Pre-Tax or Post Tax?” there isn’t one answer. You need to review the tax selections below:

a. **Medicare, Social Security, and Local Income Tax Wage Base:**
   - **Excludes:** Fringe benefit OPERS and OP&FPF
   - **Reduced:** By Cafeteria plans (26 USC § 125)

b. **Federal and Ohio Income Tax Wage Base**
   - **Excludes:** Non-tax earnings, Fringe benefit OPERS and OP&FPF
   - **Reduced:** By Salary reductions, Cafeteria plans, Deferred compensation
     Also reduced: by personal tax exemptions

c. **School Income Tax Wage Base: "State income tax wage base" school districts:**
   - **Identical to Federal and Ohio Tax Wage Base (explained above)**

d. **School Income Tax Wage Base: "Earned income only" school districts:**
   - **Identical to Federal and Ohio Tax Wage Base (explained above)**
   - but is **not** reduced by personal tax exemptions

e. **OPERS, OP&FPF, and Miscellaneous Withholding Wage Base:**
   - **Excludes:** Non-retirement earnings, Non-cash benefits, Fringe Medicare, Social Security, OPERS and OP&FPF

**Warning:** The UAN software properly applies the laws that govern taxes and retirement to calculate the taxes for wages, generate the tax reports, payments and W-2s. If you **have used the override box to adjust wage withholdings, or have over- or under-corrected items contrary to tax rates and laws**, you may need to hire a payroll tax consultant to advise you how to amend your tax reports, payments and W-2s. UAN support will **NOT** be able to assist you in determining how to amend your reports, payments, and/or W-2 forms.

Entities that did not experience any of the problems outlined above will be able to verify that the W-2s balance with the various tax district reports filed and payments made for fiscal year 2015. After these items are verified, it is safe to print the W-2 and W-3 forms.
CLIENTS THAT CONVERTED TO UAN PAYROLL MID-YEAR

Entities that began using the UAN Payroll software during fiscal year 2015 had multiple choices to convert their previously posted 2015 payroll data into UAN. Prior to the close of 2015 you still have time to add employees and post conversion wages in order to bring your prior payroll ledger balance into UAN for W-2 printing. Review the following items to determine how to prepare for the 2015 W-2s:

- If you added all employees that were paid in fiscal year 2015 and posted all the conversion wages to bring the year-to-date ledger balance into the UAN software, you can print forms W-2 and W-3 as normal.
- If you added all of your 2015 employees to the software and began posting wages, but did not post a conversion wage you have the following three options:
  
  A. **Prior to closing 2015** you can post conversion wages to bring your prior payroll ledger balance into UAN, and then print the forms W-2 and W-3 as normal.
  B. Add a W-2 for the employees and edit the figures to report the combined total of the wages paid from your prior payroll ledger and the UAN posted Payroll, and then print the forms W-2 and W-3 as normal.
  C. Manually prepare your forms W-2 and W-3, combining the UAN posted payroll data and old payroll ledger balance.
- If you did not add all of your 2015 paid employees into the UAN software and post conversion wages for them before fiscal year 2015 is closed:
  
  o Manually prepare your forms W-2 and W-3, combining the UAN posted payroll data and old payroll ledger balance.
- If you added all of your employees to the software but did not post a conversion wage or any live wages in the payroll software, **then before fiscal year 2015 is closed:**
  
  o Post conversion wages for all employees from your payroll ledger and print the W-2 and W-3 reports.
  o Manually prepare your forms W-2 and W-3 (i.e. outside of the UAN software).
- Note: The W-3 form will compile the data from the selected W-2s in the software, including any edits you have made to the W-2s, but the W-3 cannot be edited to include any manually prepared W-2s.
The lists below contain brief instructions on how to complete the prescribed steps. For more
detailed information, follow the UAN Menu Path listed to open a particular area, then click the
[Need Help?] button on the main menu for screen-specific information. Also, some areas include
links to helpful screencast video tutorials located under the FAQs menu in the lower left hand
corner of the UAN screen.

**REMOVE OR DEACTIVATE ITEMS NO LONGER NEEDED**

The beginning of the year can be a good time to ‘clean house’ in the software to easily remove or
deactivate items that will not be needed in the future. Some items may not be removable, but can
be deactivated. For example, appropriation accounts used on carryover purchase orders cannot be
removed, but they will not be needed for future activity once the final payment is made. If
desired, these can be deactivated so that they are not displayed in drop down menus and certain
reports. Deactivating an item will not affect transactions posted prior to deactivating. For
example, deactivating an account used on a carryover purchase order will not prohibit you from
making a payment using that purchase order, but will prevent you from selecting that account
when creating a new purchase order.

**Recommendation:** Using filters in the areas below can save time. In the maintenance areas,
click the ‘Status’ drop down menu. In the reports areas, click the ‘Filters’ tab.

**Remove or deactivate funds, revenue and appropriation accounts**

When the year is closed, revenue and appropriation budgets are set to zero, but the account codes
are retained unless they were marked to be removed in the year end checklist. The order below is
important because funds cannot be removed until all revenue and appropriation accounts in that
fund are removed.

<table>
<thead>
<tr>
<th>Actions</th>
<th>UAN Menu Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Remove or deactivate unneeded revenue accounts</td>
<td>Accounting  Maintenance  Revenue Accounts</td>
</tr>
<tr>
<td>□ To review the account list, print the Revenue Chart of Accounts</td>
<td>Accounting  Reports &amp; Statements  Revenue Reports</td>
</tr>
<tr>
<td>□ Remove or deactivate unneeded appropriation accounts</td>
<td>Accounting  Maintenance  Appropriation Accounts</td>
</tr>
<tr>
<td>□ To review the account list, print the Appropriation Chart of Accounts</td>
<td>Accounting  Reports &amp; Statements  Appropriation Reports</td>
</tr>
<tr>
<td>□ Remove or deactivate unneeded funds</td>
<td>Accounting  Maintenance  Funds</td>
</tr>
</tbody>
</table>
To review the account list, print the Fund Chart of Accounts

Delete or deactivate Vendors / Payees
Vendors that will never be used can be deleted. A vendor can be deleted only if there have never been any cash transactions with that vendor and there are no current encumbrances using the vendor. All other vendors that will not be needed in the future can be deactivated.

<table>
<thead>
<tr>
<th>Actions</th>
<th>UAN Menu Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove or deactivate unneeded Vendors / Payees</td>
<td>General → Maintenance → Vendors / Payees</td>
</tr>
<tr>
<td>To review the vendor list, print the Vendor / Payee Listing</td>
<td>General → Reports &amp; Statements → Vendor / Payee Reports</td>
</tr>
</tbody>
</table>

ADD NEW MAINTENANCE ITEMS

ADD NEW ACCOUNT CODES AND VENDORS

Add new items (if needed) to be used in 2016.

Note: If you make use of cost centers (optional), they should be added before revenue and appropriation accounts.

Add new funds, revenue, appropriation accounts, and vendor / payees.

<table>
<thead>
<tr>
<th>Actions</th>
<th>UAN Menu Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add new funds</td>
<td>Accounting → Maintenance → Funds</td>
</tr>
<tr>
<td>Add new cost centers (if used)</td>
<td>Accounting → Maintenance → Cost Centers</td>
</tr>
<tr>
<td>Add new revenue accounts</td>
<td>Accounting → Maintenance → Revenue Accounts</td>
</tr>
<tr>
<td>Add new appropriation accounts</td>
<td>Accounting → Maintenance → Appropriation Accounts</td>
</tr>
<tr>
<td>Add new vendors / payees</td>
<td>General → Maintenance → Vendors / Payees</td>
</tr>
</tbody>
</table>
**ADD REVENUE BUDGETS**

Add 2016 revenue budgets for each fund. The entity will not be able to appropriate more than the January 1st cash balance in each fund until the revenue budget is entered. Another reason this needs to be completed accurately is so that 2016 annual financial reports will be correct.

The revenue budget is an estimate of an entity’s anticipated revenue from taxes and other sources during the year. The total per fund of each revenue budget should equal the tax revenue and other sources on the Certificate of Estimated Resources provided by the County Budget Commission.

<table>
<thead>
<tr>
<th>Actions</th>
<th>UAN Menu Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Add revenue budgets</td>
<td>Accounting ➔ Maintenance ➔ Revenue Budgets, then click [Add]</td>
</tr>
<tr>
<td>□ Print the Resources Available for Appropriation report</td>
<td>Accounting ➔ Reports &amp; Statement ➔ Budgetary Reports</td>
</tr>
<tr>
<td>□ Confirm the Estimated Revenue column for each fund matches total of the ‘Taxes’ and ‘Other Sources’ columns for each fund on the most recent 2016 Amended Certificate of Estimated Resources from the budget commission.</td>
<td></td>
</tr>
<tr>
<td>□ Print the Revenue Status to confirm individual amounts were entered correctly.</td>
<td>Accounting ➔ Reports &amp; Statement ➔ Revenue Reports</td>
</tr>
</tbody>
</table>

**ADD APPROPRIATION BUDGETS**

Add 2016 appropriation budgets for each fund. New purchase orders and payments cannot be recorded until appropriation budgets are entered.

An appropriation budget is the amount that the entity expects to spend on each appropriation account (line item) for the year. If needed, a temporary appropriation ordinance to control expenditures may be passed on or about January 1 of each year, for the period January 1 to March 31. The temporary appropriation budget amounts can be an estimate of what will be spent for up to the first three months. An annual appropriation ordinance must be passed by April 1 of each year, for the period January 1 to December 31. The permanent appropriation budget amounts must be an estimate of what will be spent for the entire year.
### Actions

<table>
<thead>
<tr>
<th></th>
<th>UAN Menu Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add appropriation budgets</td>
<td>Accounting ➔ Maintenance ➔ Appropriation Budgets, then click [Add]</td>
</tr>
<tr>
<td>Print the Appropriation Status to confirm individual amounts were entered correctly</td>
<td>Accounting ➔ Reports &amp; Statement ➔ Appropriation Reports</td>
</tr>
<tr>
<td>Print the Comparison of Budget and Appropriation report</td>
<td>Accounting ➔ Reports &amp; Statement ➔ Budgetary Reports</td>
</tr>
<tr>
<td>Confirm the Final Appropriation amount for each fund equals the fund subtotals on the appropriation ordinance. The Variance column should be zero or positive for each fund.</td>
<td></td>
</tr>
</tbody>
</table>

If the variance amount listed is negative, then your Final Appropriation budget in UAN exceeds the amount Total Estimated Resources for that fund. **Double check for data entry errors** by reviewing the Appropriation Status and Revenue Status reports. If there are no data entry errors in the revenues or appropriations inputted in the UAN system, then it appears your entity is stating on the Appropriation Ordinance / Resolution that it is planning to spend more than the total available resources for that fund as stated on the latest Amended Certificate of Estimated Resources.

This situation should be resolved – consult with the board/council to discuss a resolution and/or consult with the county auditor.

### ADD NEW INVESTMENTS

Add any new investments for the year.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Add new investment account information under Accounting ➔ Maintenance ➔ Investments and click [Add]. Click [Save] when finished and repeat for each investment.</td>
<td></td>
</tr>
<tr>
<td>Upon closing the investment form you will be prompted print a new investment report. Click [Yes] to print.</td>
<td></td>
</tr>
<tr>
<td>Then the system prompts to open the Investment Transfer form. Click [Yes] or to open it later go to Accounting ➔ Transaction ➔ Investment Transfer.</td>
<td></td>
</tr>
<tr>
<td>Upon closing the investment transfer form you will be prompted to print an investment transfer report. Click [Yes] to print.</td>
<td></td>
</tr>
</tbody>
</table>
**ADD NEW PURCHASE ORDERS**

To make payments using appropriations in the new year’s budget you will need purchase orders detailing the authorization and commitment to purchase goods or services.

<table>
<thead>
<tr>
<th>Actions</th>
<th>UAN Menu Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Click [Add] and select the type of purchase order</td>
<td>Accounting ➔ Transactions ➔ Purchase Orders</td>
</tr>
<tr>
<td>□ Print the Purchase Order Status report</td>
<td>Accounting ➔ Reports &amp; Statement ➔ Purchase Order Reports</td>
</tr>
</tbody>
</table>

**BEGIN 2016 TRANSACTIONS**

You can now begin posting 2016 accounting transactions.

**Note:** If you had recorded any 2016 transactions manually *(not using the UAN software)* before you opened Temporary Mode or closed the year, then enter those transactions in UAN in the exact sequence, date-by-date until all are recorded. Then begin new transactions.
When you open Temporary Mode in 2015 you will be able to log into work year 2016. Temporary Mode allows you to work in both fiscal years 2015 and 2016 before closing fiscal year 2015, which provides many potential advantages. Opening Temporary Mode is a required step in the year end process, but working in 2016 before closing 2015 is completely optional. During Temporary Mode, you may select the work year upon login. See below:

Although you will be able to log into work year 2016 to begin your new year payroll procedures, you must pay particular attention to the effective date of the changes.

For example, local and school tax rates become effective January 1. Therefore, a new withholding for the local or school tax must be added and then added to each employee before the first wages are posted in the new year. A change to the rate of an existing local or school tax must be edited to the new rate and the employees updated (using the Withholding Editor) before the first wages are posted in the new year.

Likewise, you may have employees that receive pay increases or leave balance adjustments that take effect January 1. Before you update the employees in work year 2016 make sure you will be posting a pay period that includes the effective date of these local policy items.

**Caution! Leave balance adjustments in Temporary Mode:** UAN recommends you post all final wages in work year 2015 before making any leave balance adjustments in work year 2016. Wages posted in 2015 may impact the amount you should adjust in 2016, so wait until all 2015 wages are posted before adjusting leave for the new year as required by your policy.

**Reminder:** Leave balance corrections or changes are entered under Payroll → Utilities → Leave Balance Adjustment, NOT under Payroll → Maintenance → Employees.

If you choose to close fiscal year 2015 before accessing fiscal year 2016 you will begin the new year procedures once the 2015 close is completed. You will still need to pay particular attention to the effective date of the changes.
The lists below contain brief instructions on how to complete the prescribed steps. For more detailed information, follow the UAN Menu Path listed to open a particular area and then click the [Need Help?] button on the main menu for screen-specific information. Also, some areas include links to helpful screencast video tutorials located under the FAQs menu in the lower left hand corner of the UAN screen.

**UPDATE MAINTENANCE ITEMS**

<table>
<thead>
<tr>
<th>Actions</th>
<th>UAN Menu Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add new Additional Information items</td>
<td>Payroll → Maintenance → Additional Information, click [Add]</td>
</tr>
<tr>
<td>(Use of additional information is optional)</td>
<td>• Enter the name of the new item</td>
</tr>
<tr>
<td></td>
<td>• Enter the description</td>
</tr>
<tr>
<td></td>
<td>• Set the display order</td>
</tr>
<tr>
<td></td>
<td>• Mark desired sensitivity level</td>
</tr>
<tr>
<td></td>
<td>• Click Save and Close</td>
</tr>
<tr>
<td>Add New Earning or Leave to be attached to employees</td>
<td>Payroll → Maintenance → Earnings and Leave, Click [Add]</td>
</tr>
<tr>
<td></td>
<td>• Enter a new Earning/Leave Name (must be different than existing items)</td>
</tr>
<tr>
<td></td>
<td>• Select the Type</td>
</tr>
<tr>
<td></td>
<td>• OP&amp;FPF Type (OP&amp;FPF Employers only)</td>
</tr>
<tr>
<td></td>
<td>• Save &amp; Close</td>
</tr>
<tr>
<td>Edit employee to add new earning to an employee</td>
<td>Add New Withholding to be attached to employees</td>
</tr>
<tr>
<td></td>
<td>If new Vendor/Payee needs to be added, first go to General → Maintenance → Vendor/Payee Click Add</td>
</tr>
<tr>
<td></td>
<td>• Enter Name of the Vendor</td>
</tr>
<tr>
<td></td>
<td>• Mark ☑ Payroll Withholding</td>
</tr>
<tr>
<td></td>
<td>• Enter account #1</td>
</tr>
<tr>
<td></td>
<td>• Add location if necessary</td>
</tr>
<tr>
<td></td>
<td>• Save &amp; Close Add Location form</td>
</tr>
<tr>
<td></td>
<td>• Save &amp; Close Add Vendor/Payee form</td>
</tr>
<tr>
<td></td>
<td>If the Vendor/Payee already exists go to Payroll → Maintenance → Withholdings, Click Add</td>
</tr>
<tr>
<td></td>
<td>• The Withholding Name must be different than existing items</td>
</tr>
<tr>
<td></td>
<td>• Select the Process Group</td>
</tr>
<tr>
<td>Action</td>
<td>Steps</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Add New Withholding to be attached to employees                        | • Select Payee  
• Complete required items on the Details tab for the amount or rate of the withholding.  
• Save and Close.  
Edit employee to add new Withholding to an employee |
| Edit existing Withholding to change to new rate                        | Payroll → Maintenance → Withholdings  
• Mark Withholding  
• Click Edit  
• Update the rate or amount to the new rate  
• Save and Close |
| Update all employees to new Withholding rate at once using the Withholding Editor | Payroll → Maintenance → Withholdings Editor  
• Select Withholding from the drop down list  
• Mark all employees to be updated to the new rate  
• Enter the new rate in the correct box in the lower portion of the Withholding Editor.  
• Click Save.  
• Verify Employees in the list have been updated to the correct rate. Close. |
| Add and Apply Skip Calendars (when applicable) using the Skip Calendars Editor | Payroll → Maintenance → Skip Calendars Editor  
• This is a very convenient option when an employee withholding for multiple employees should be set to skip *(not be deducted on)* certain pay periods.  
• Note: employee specific maintenance items may need updated before adding/applying skip calendars. To access a detailed description of this feature, click the ‘Overview’ link in the lower left hand corner under the FAQs menu when this area is open. |
### UPDATE EMPLOYEE-SPECIFIC MAINTENANCE ITEMS

<table>
<thead>
<tr>
<th>Actions</th>
<th>UAN Menu Path</th>
</tr>
</thead>
</table>
| Update Employee Information (Such as Address, Contact Information, Pay Status, and Tax Exemptions) | Payroll ➔ Maintenance ➔ Employees  
- Mark the employee, Click Edit and Advanced  
- On the Employee Information tab update information as needed.  
- Save and Close |
| Edit Employee and update Additional Information (Use of additional information is optional, many entities do not use these items) | Payroll ➔ Maintenance ➔ Employees  
- Mark the employee, Click Edit and Advanced  
- Click on the Additional Info Tab  
- Enter information as needed.  
- Save and Close |
| Edit Employee Earning | Payroll ➔ Maintenance ➔ Employees  
- Mark the employee, Click Edit and Advanced  
- Click on the Earnings Tab  
- Mark the Earning  
- Click Edit  
- Make changes to earning such as pay rate, attached Overtime, Non-Cash, Leaves and Withholdings  
- Click Save and Close |
| Add New Employee Earning | Payroll ➔ Maintenance ➔ Employees  
- Mark the employee, Click Edit and Advanced  
- Click on the Earnings Tab  
- Click Add (The Add Earning form opens) (Do not click save until you have completed all steps below)  
- Complete all items on the top left and right of the form for the new earning  
- Click on the Withholdings Tab and attach the withholdings that should be applied to the earning.  
- Click on the Accounts Tab and select the split method and add all accounts that will pay the earning  
- If necessary, click on the Overtime and Non-Cash tabs to attach new items to this earning.  
- Click Save and Close |
| Deactivate Employee Earning | Payroll ➔ Maintenance ➔ Employees  
- Mark the employee, Click Edit and Advanced  
- Click on the Earnings Tab  
- Mark the Earning |
<table>
<thead>
<tr>
<th>Action</th>
<th>Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>Editing Employee Overtime</td>
<td>1. Payroll → Maintenance → Employees</td>
</tr>
<tr>
<td></td>
<td>2. Mark the employee, Click Edit and Advanced</td>
</tr>
<tr>
<td></td>
<td>3. Click on the Overtime Tab</td>
</tr>
<tr>
<td></td>
<td>4. Mark the Overtime</td>
</tr>
<tr>
<td></td>
<td>5. Click Edit</td>
</tr>
<tr>
<td></td>
<td>6. Make necessary changes to Overtime such as base pay rate, overtime rate, or attached Earning</td>
</tr>
<tr>
<td></td>
<td>7. Click Save and Close</td>
</tr>
<tr>
<td>Adding New Employee Overtime</td>
<td>1. Payroll → Maintenance → Employees</td>
</tr>
<tr>
<td></td>
<td>2. Mark the employee, Click Edit and Advanced</td>
</tr>
<tr>
<td></td>
<td>3. Click on the Overtime Tab</td>
</tr>
<tr>
<td></td>
<td>4. Click Add (The Add Overtime form opens) (Do not click save until you have completed all steps below)</td>
</tr>
<tr>
<td></td>
<td>5. Enter base pay rate and overtime rate</td>
</tr>
<tr>
<td></td>
<td>6. Click on the Earnings tab and attach to one earning.</td>
</tr>
<tr>
<td></td>
<td>7. Click on the Accounts Tab and select the split method and add all accounts that will pay the overtime.</td>
</tr>
<tr>
<td></td>
<td>8. Click Save and Close</td>
</tr>
<tr>
<td>Deactivating Employee Overtime</td>
<td>1. Payroll → Maintenance → Employees</td>
</tr>
<tr>
<td></td>
<td>2. Mark the employee, Click Edit and Advanced</td>
</tr>
<tr>
<td></td>
<td>3. Click on the Overtime Tab</td>
</tr>
<tr>
<td></td>
<td>4. Mark the Overtime</td>
</tr>
<tr>
<td></td>
<td>5. Click Deactivate</td>
</tr>
<tr>
<td></td>
<td>6. Click Save and Close</td>
</tr>
<tr>
<td>Editing Employee Non-Cash Benefit</td>
<td>1. Payroll → Maintenance → Employees</td>
</tr>
<tr>
<td></td>
<td>2. Mark the employee, Click Edit and Advanced</td>
</tr>
<tr>
<td></td>
<td>3. Click on the Non-Cash Tab</td>
</tr>
<tr>
<td></td>
<td>4. Mark the Non-Cash Benefit</td>
</tr>
<tr>
<td></td>
<td>5. Click Edit</td>
</tr>
<tr>
<td></td>
<td>6. Make changes such as rate</td>
</tr>
<tr>
<td></td>
<td>7. Click the Earning tab to change attached Earning.</td>
</tr>
<tr>
<td></td>
<td>8. Click Save and Close</td>
</tr>
<tr>
<td>Adding New Employee Non-Cash Benefit</td>
<td>1. Payroll → Maintenance → Employees</td>
</tr>
<tr>
<td></td>
<td>2. Mark the employee, Click Edit and Advanced</td>
</tr>
<tr>
<td></td>
<td>3. Click on the Non-Cash Tab</td>
</tr>
<tr>
<td></td>
<td>4. Click Add (The Add Non-Cash Benefit form opens)</td>
</tr>
<tr>
<td>Deactivate Employee Non-Cash Benefit</td>
<td>(Do not click save until you have completed all the steps below)</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>• Select the Non-Cash benefit from the drop down list. (Item must have a different description than any existing Non-Cash Benefit – change description if necessary)</td>
<td></td>
</tr>
<tr>
<td>• Enter the pay amount (can be 0.00 but not blank)</td>
<td></td>
</tr>
<tr>
<td>• Click on the Earnings Tab and attach to one Earning</td>
<td></td>
</tr>
<tr>
<td>• Click Save and Close</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edit Employee Leave</th>
<th>Payroll → Maintenance → Employees</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Mark the employee, Click Edit and Advanced</td>
<td></td>
</tr>
<tr>
<td>• Click on the Non-Cash Tab</td>
<td></td>
</tr>
<tr>
<td>• Mark the Non-Cash Benefit</td>
<td></td>
</tr>
<tr>
<td>• Click Deactivate</td>
<td></td>
</tr>
<tr>
<td>• Click Save and Close</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Add New Employee Leave</th>
<th>Payroll → Maintenance → Employees</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Mark the employee, Click Edit and Advanced</td>
<td></td>
</tr>
<tr>
<td>• Click on the Leaves Tab</td>
<td></td>
</tr>
<tr>
<td>• Click Add (The Add Employee Leave form opens) (Do not click save until you have completed all the steps below)</td>
<td></td>
</tr>
<tr>
<td>• Select the Leave from the drop down list. (Item must have a different description than any existing Leave – change description if necessary)</td>
<td></td>
</tr>
<tr>
<td>• Enter the pay amount and the correct setting for hourly or salary employee</td>
<td></td>
</tr>
<tr>
<td>• Click on the Earnings Tab and attach the Leave to all earnings that should be associated with the leave</td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>Steps</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Deactivate Employee Leave | Payroll → Maintenance → Employees  
Mark the employee, Click Edit and Advanced  
Click on the Leaves Tab  
Mark the Leave  
Click Deactivate  
Click Save and Close                                                                 |
| Edit Employee Withholding  | Payroll → Maintenance → Employees  
Mark the employee, Click Edit and Advanced  
Click on the Withholding Tab  
Mark the Withholding  
Click Edit  
Make changes such as rate or amount  
Click on the Earnings tab to view or change the earnings attached to this withholding  
If this withholding has an Employer Share Click on the Appropriations Accounts (Employer Share) tab and select the split method and appropriation accounts that will pay the employer share  
If this is a withholding that has a fringe benefit option click on the Fringe Benefits tab and select the split method and appropriation accounts that will pay the fringe benefit.  
Click Save and Close                                                                 |
| Add New Employee Withholding | Payroll → Maintenance → Employees  
Mark the employee, Click Edit and Advanced  
Click on the Withholdings Tab  
Click Add (The Add Employee Withholding form opens) (Do not click save until you have completed all the steps below)  
Select the Withholding from the drop down list. (Item must have a different description than any existing Withholding – change description if necessary)  
Make changes such as rate or amount  
Click on the Earnings tab and you **MUST** mark the |
earnings to be attached to this withholding
- If this withholding has an Employer Share Click on the Appropriations Accounts (Employer Share) tab and select the split method and appropriation accounts that will pay the employer share
- If this is a withholding that has a fringe benefit option click on the Fringe Benefits tab and select the split method and appropriation accounts that will pay the fringe benefit.
- Click Save and Close

☐ Deactivate Employee Withholding

Payroll → Maintenance → Employees
- Mark the employee, Click Edit and Advanced
- Click on the Withholdings Tab
- Mark the Withholding
- Click Deactivate
- Click Save and Close

If you need to adjust leave balances in the new year, pay particular attention to the date you are paying wages, the pay period of the wages, and the date the leave changes are effective pursuant to your policy, and then adjust them at the proper time.

Steps To Access: Payroll → Utilities → Leave Balance Adjustment. You will always receive a system message advising you that supporting documentation should be retained for all leave balance adjustments; they are closely scrutinized at audit. Click OK.

On the Post Leave Balance Adjustment Form you can select to adjust By Employee to adjust one employee at a time or select By Leave to adjust all employees with the same leave at once.

Make adjustments as positive or negative numbers in the adjustment column. Enter the reason for the adjustment (i.e. 2016 Leave Granted or 2015 Unused leave lost per policy). Enter the effective date of the leave adjustment and click Post. Leave reports can be printed to verify correct balances:

Steps To Access: Payroll → Reports & Statements → Leave Reports, select the desired report from the drop down list, select the employees, and then click Print.
APPENDIX 5: YEAR END BALANCES CERTIFICATES

UAN provides a template for the ‘Certificate Of The Total Amount From All Sources Available For Expenditures, And Balances’, also referred to as the Year End Balances Certificate. The area for creating this is located in the Budget module:

**STEPS TO ACCESS**

Budget → Transactions → Year End Balances Certificates

**IMPORTANT:** The year end certificate should only be added after ALL fiscal year 2015 transactions, utility adjustments, and the 12/31/2015 bank reconciliation has been posted.

To add a year end balances certificate with balances as of 12/31/2015, log into UAN either by selecting Work Year 2016 when Temporary Mode is open OR in 2016 after the fiscal year 2015 is closed. Go to Budget → Transactions → Year End Balances Certificates and confirm the default year - 2016 - is selected from the Year drop-down menu. Then click the Add button to open an Add Year End Balances Certificates form with “Balances as of 12/31/2015”.

**Note:** If you attempt to add the certificate while working in fiscal year 2015 (with 2015 selected in the Year drop-down menu) the Add Year End Balances Certificates form will open, but it will pull in “Balances as of 12/31/2014”.

**[ADD]**

A certificate name must be specified when adding a year end balances certificate. All funds from the current and prior year are displayed and all amounts can be edited.

The Add form has two tabs: The Funds tab shows all funds and allows for edits to the data. The Display-Summary tab is read-only; displaying the data *(including edits)* from the Funds tab. The Display-Summary tab shows totals summed by fund type (*General, Special Revenue...etc.*) with totals for Governmental, Proprietary, and Fiduciary funds, and a total for all funds.

**[EDIT]**

When a certificate is edited, any amounts saved to the worksheet that differ from the amounts calculated by UAN will be listed in a popup form ‘Update Year End Balances’. Optionally, any of the differing amounts on the certificate can be automatically updated to the amount calculated by UAN by selecting amount on the pop-up form to import.

(See Edit and Delete restrictions note below).

**[DELETE]**

Use to delete year end balances certificates. (See Edit and Delete restrictions note below).
Edit and Delete restrictions for prior years

Year end certificates that may have been added in previous years cannot be edited or deleted after closing the fiscal year. For example, any 2014 year end balances certificate that was added by the user while logged into 2015 (whether before or after opening Temporary Mode) will be unavailable to edit or delete after closing fiscal year 2015.

[PRINT] / [DISPLAY] / [SAVE PDF]

A summary page will be produced along with a listing of all the funds on the certificate.

[PRINT BLANK] – located next to the add button

If needed, a blank copy of the certificate may be printed.

EXPLANATIONS OF COLUMN HEADINGS – YEAR END BALANCE CERT.

Note: The following information assumes a year end balances certificate is being added for balances as of 12/31/2015 while logged into UAN either by selecting Work Year ☐ 2016 when Temporary Mode is open OR in 2016 after the fiscal year 2015 is closed.

1. Cash Balances as of 12/31/2015

Definition: Cash balances per the cash book of the governmental entity as of December 31.

Location in UAN: Prior year report, as of 12/31/2015
The ‘Fund Balance as of 12/31/2015’ on the Cash Summary by Fund report. Menu path: Accounting ➔ Reports and Statements ➔ Fund Reports, select Cash Summary by Fund and select 2015 from the Year drop-down menu.

2. Reserved for Encumbrance as of 12/31/2015

Definition: All outstanding unliquidated encumbrances as of December 31, obligations in the form of purchase orders or contracts which were charged to a prior year’s appropriation and for which a part of that appropriation is reserved (carryover purchase orders and withholdings).

Location in UAN: Prior year report, as of 12/31/2015
The ‘Current Reserve for Encumbrance’ on the Fund Summary report. Menu path: Accounting ➔ Reports and Statements ➔ Management Reports, select Fund Summary and select 2015 from the Year drop-down menu.
3. Reserved for Non-Spendable Balance as of 12/31/2015

**Definition:** Reserve for funds that require non-expendable balances such as permanent funds and some private purpose trust funds. The non-expendable balances are set in Accounting ➔ Maintenance ➔ Funds.

**Location in UAN:** Prior year report, as of 12/31/2015
The ‘Reserved for Non-Spendable Balance 12/31’ column on the Resources Available for Appropriation report. Menu path: Accounting ➔ Reports and Statements ➔ Budgetary Reports, select Resources Available for Appropriation and 2015 from the Year drop-down menu.

4. Reserve Balance Accounts

**Definition:** Reserve Balance Accounts as per sections 5705.13(A)(1) and/or 5705.132 of the Ohio Revised Code (ORC).

**Location in UAN:** Prior year report, as of 12/31/2015
The ‘Reserve Balance (5705.13(A)(1) & 5705.132) 12/31’ column on the Resources Available for Appropriation report. Menu path: Accounting ➔ Reports and Statements ➔ Budgetary Reports, select Resources Available for Appropriation and 2015 from the Year drop-down menu.

5. Advances Not Repaid

**Definition:** Advances not repaid as of December 31st ---this amount should be added to the fund that made the advance and subtracted from the fund that will be making the reimbursement.

**Location in UAN:** Current year report, as of 1/1/2016
The ‘Prior Year Advances Not Repaid 12/31’ column on the Resources Available for Appropriation report. Menu path: Accounting ➔ Reports and Statements ➔ Budgetary Reports, select Resources Available for Appropriation and 2016 from the Year drop-down menu.

6. Carryover Balances Available for Appropriations

**Calculation:** Columns 1 – 2 – 3 – 4 + 5 = Column 6
Cash Balance 12/31 (column #1) minus Reserved for Encumbrance 12/31 (column #2) minus Reserved for Non-Spendable Balance 12/31 (column #3) minus Reserve Balance Accounts (column #4) plus Advances not Repaid (column #5)

7. Total Amount from All Sources Available for Expenditures
**Definition:** The total amount from all sources the governmental unit expects to receive during the forthcoming fiscal year which is available for expenditures.

**Location in UAN:** *Current year* report, as of 1/1/2016

Accounting → Reports & Statements → Revenue Reports, then select Revenue Budget and 2016 from the Year drop-down menu. Locate the amount for each fund sub-total in the Final Budget column. Note: The total per fund of each revenue budget should equal the tax revenue and other sources on the Certificate of Estimated Resources provided by the County Budget Commission.

**8. Total Amount Available plus Balances**

**Calculation:** Columns 6 + 7 = Column 8
Carryover Balance Available for Appropriations (column #6) plus Total Amount from all Sources Available for Expenditures (column #7)
APPENDIX 6: MAPPING FUNDS

The mapping section of the AFR – Fund Utility is for miscategorized or ancillary (subsidiary) funds only. Many UAN entities will have no need to map any of their funds. The default setting is ‘Not Mapped.’ When a fund is ‘mapped to’ another fund, it means the current fund’s balance will be considered part of the selected fund’s balance for annual financial statement purposes.

Clicking ‘Map To’ requires you to pick another fund that the current fund will be ‘mapped to’. When a fund is mapped to another fund:

- The cash balance of that fund will be included in the ‘Map To’ fund for the purpose of annual financial statements only.
- The mapped fund takes on all characteristics of the fund it is mapped to.
- If the characteristics of a fund that it is mapped to are changed, the mapped fund is updated to match.
- The mapping information will not be carried over to the next year. The proper fund will need to be added once the entity is in the new year.
- You can map several funds to one fund, but a fund cannot be mapped to a fund that is also mapped to another fund.
- The General fund is not allowed to be mapped to another fund.

A typical example is if the fiscal officer determines money was miscategorized in 2015, but it won’t be corrected until the beginning of 2016. Mapping will allow the fund to be categorized correctly for the purposes of the 2015 annual financial reports. After 2015 is closed, the balance of the fund should be moved to the fund to which it was mapped. Similarly, if this option is used to map a fund to a completely new fund, the original fund balance should be moved to the new fund after closing the year. Another example is the possibility that an Unclaimed Monies fund balance might need to be reported in the fund that will eventually receive the money (usually the General fund). This can be achieved by mapping.

For questions regarding whether or not a fund should be mapped to another, please contact Local Government Services at 1-800-345-2519.

If you map a fund in the AFR – Fund Utility, you can view the impact it has on the fund it is ‘mapped to’ with the Mapping report.

STEPS TO ACCESS
General → Reports & Statements → Year End → AFR – OCBOA Statements, then select Mapping and the year from the drop-down menus.

Note: You can print this report even if you file Regulatory AFR.
Follow these steps if for any reason you need to re-create the AFR-AOS Backup file. For example, it is possible to successfully close the year, but accidently cancel the AFR-AOS Backup form before the audit submission file (or disc) is created.

**IMPORTANT:** Resubmitting your AFR – AOS Backup will update your annual financial report filing date. This resubmission date must still fall within the legal deadline for submitting your AFR for the year - financial penalties may be assessed for late filings. Each local government is required to submit their Annual Financial Report to the Auditor of State within **sixty (60) days of the end of the fiscal year**. Meeting this requirement for UAN members occurs when the 2015 AFR file (or disc) containing the end of year filing data of the government is received by UAN.

**STEPS TO ACCESS**

General → Maintenance → Year End → AFR – AOS Backups. Read the system message carefully and click OK.

Unlike other backups, this backup file name cannot be edited. You can either create a file to submit online (Option #1) or create a disc to mail (Option #2). UAN recommends submitting the file online for entities that have access to a high speed internet connection.

**Option 1: Create a file to submit online:**

Select the backup destination: ‘Internet Submission – E-Files Directory.’ Then click [Start].

When the backup is complete, a message will appear with instructions for submitting the file to the Auditor of State. The audit submission file will be saved under the C:\_UAN_Efiles directory. The file will be named ‘xxxx_2015_AFR.uan’ except that instead of ‘xxxx’ it will contain the entity’s four digit UAN entity Id number. You will be prompted to select that file at the time that you make the submission online. Carefully read the additional information in the message and click [OK]. Click [Close] to close the AFR-AOS Backup form.

In addition to the onscreen instructions, specific steps for submitting the file to meet the AFR requirements for the Auditor of State are outlined in this booklet starting on page 28.

**To create a disc to mail - instead of a file to submit online - see Option 2 on the next page**
Option 2: Create a disc to mail:
Select the backup destination: ‘Postal Submission – CD or DVD.’ Insert a blank disc in the CD/DVD tray and close it. Then click [Start].

When the backup is complete, the backup form will close, a message will open stating your “AFR – AOS Backup disc has been created” and the disc will be ejected. Immediately label the disc. The AFR – AOS backup for audit submission disc should be labeled in the following manner:

2015 AFR
Your Entity Name
Your County Name
Your UAN Entity ID Number

Carefully read the additional information in the message and click [OK]. Click [Close] to close the AFR-AOS Backup form.

In addition to the onscreen instructions, specific steps for submitting the disc to meet the AFR requirements for the Auditor of State are outlined in this booklet starting on page 28.

**To create a file for online submission - instead of mailing a disc - see Option 1 on the previous page**